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◆ Introduction

Thank you for choosing Interiors, the affordable, easy to use space planning application 
Macintosh®. Designed for novices as well as professionals, Interiors provides the tools 
need to create realistic, 3D interior designs.

In addition to a core application suitable for viewing and manipulating existing 3D files, In
ors offers a plug-in architecture that makes it easy to add tools and extend the program’
tionality. Plug-ins can be palettes, tools, menu items or idlers and can be loaded as the 
application is launched or ‘hot’ loaded while Interiors is running. Information about the pl
ins included is provided in this manual.

Additional rendering options, such as transparent surfaces are available through suppor
QuickDraw 3D hardware renderers, and plug-in renderers from Microspot and third party
companies can be accessed by Interiors if they are installed in the Extensions folder. Int
includes the Microspot plug-in renderer.

Take a look at the extra items on the CD which are not installed on your hard drive durin
installation procedure. Demo copies of 3D World, PhotoFix, MacDraft, MacPalette and M
Plot drivers are included for those who are interested in other Microspot products.

◆ Requirements

Interiors minimally requires:

• Power Macintosh™ with CD drive

• System 7.1.2 or later

• QuickDraw™ 3D 1.0.2 or later (The version of QuickDraw 3D available at release da
included.)

• 16 Mb RAM to install QuickDraw 3D

• Drag & Drop Manager (built into System 7.5 and later)
1-2
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◆ Installation

Before installing Interiors, we recommend that you turn off any virus protection software.

1. Insert the CD into the CD drive and double click on the CD icon on the desktop to
play its contents.

2. Double-click on the Interiors Installer icon:

Follow the instructions in the dialogs that display to install the complete Interiors applica
plug-ins and QuickDraw 3D software. After installation you will need to restart your Mac.

The QuickDraw 3D software will be installed in the appropriate places on your hard drive
Microspot Renderer will be installed in the Extensions folder. The remaining items will be
placed in a folder called Interiors 3.1, on your hard drive.

◆ Registering Interiors

To register your copy of Interiors run the Register Now utility and follow the instructions t
display. Enter your name, company name (if applicable) and serial number in the registr
dialog and click OK. You can then register further Microspot products if you wish. If you d
not register the product it will run in demo mode and you will not be able to save, print or
export data.

If you do not register the product using the Register Now utility, each time you launch the
application you will be given the opportunity to register it.
1-3
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◆ Plug-ins

The Interiors’ plug-in architecture allows plug-ins to be used to add functionality to the a
cation in many different ways. Plug-ins may be available in more than one category:

Import Plug-ins:  Plug-in functions accessed via the Import submenu in the File menu.

Export Plug-ins:  Plug-in functions accessed via the Export submenu in the File menu.

There are no Export plug-ins included in Interiors.

Menu Plug-ins:  Plug-in functions accessed via the Plug-in menu in the application menu 

Plug-in Palettes:  Palettes provide a range of options for a specific feature. Display a palet
selecting its name from the Palettes menu.

Idler Plug-ins:  Run constantly once loaded.

There are no Idler plug-ins included in Interiors.

Plug-in Geometries:  Plug-in tools to create shapes. Accessed from the Tools Palette.

MacInteriors

Auto Save Construct Idler Gravity

Ceilings Floors

Color Palette NaviCam Textures

Cursor Options Nudge Tripod

Libraries Renderer Options Windows and Doors

Lights

4 Walls Walls Windows and Doors

Furnishings
1-4
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Plug-in ModiÞers:  Plug-in tools to modify objects. Accessed from the Tools Palette.

Plug-in Renderers:  Plug-in QuickDraw 3D renderers accessed through the Renderer Optio
palette.

◆ Installing Plug-ins

The Interiors’ plug-in architecture makes it easy to ‘custom build’ the application. Plug-ins
be palettes, tools, menu items or idlers. 

Plug-ins can be loaded when the application starts up by placing them in the Plug-ins fo
inside the Interiors 3.1 Folder. Plug-ins can also be ‘hot’ loaded as needed, individually o
groups, while the application is running.

To make the best use of available memory it is recommended that the plug-ins always u
with Interiors are placed in the Plug-ins folder and loaded when the application is launch
Additional plug-ins can then be loaded as required while the application is running.

When Import, Export, Idler, Menu Command and Palette plug-ins are loaded they appear
appropriate locations in the application menus. Palettes loaded when Interiors is launche
be opened if they were open last time the application was closed. Palettes loaded when
application is running will open automatically. Plug-in Geometries and Modifiers will be 
added to the Tools palette, which grows dynamically to accommodate them. See Configuring 
The Tools Palette on page F-2 for more details.

Brief information about Interiors plug-ins is available via the Apple Menu. Select About P
ins from the Apple Menu and a pop-up menu lists the installed plug-ins. Select the name
plug-in to display a dialog containing information about that plug-in.

Loading Plug-ins when Interiors is Launched

Place any plug-ins to be loaded when Interiors is launched inside the Plug-ins folder. Plu
can be grouped inside folders and the folders placed in the plug-ins folder if required. Th

Gravity Print Take Picture

Light Director Sun Direction VR

Microspot Renderer
1-5
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allows you to group plug-ins together in folders as per your requirements, and load or un
them as a group by dragging the folder in or out of the Plug-ins folder.

Note:  Hold down the Shift key when launching Interiors to stop all plug-ins from loading.

Note:  Plug-in renderers from Microspot or third party companies can be accessed by Inte
if they are installed in the Extensions folder. 

Loading Plug-ins while Interiors is Running

Plug-ins not loaded when Interiors is launched can be loaded, while the application is ru
in the following ways:

• Double click on a plug-in icon in the Finder.

• Drag a plug-in icon into the Interior’s Tools palette.

• Drag a plug-in icon into the main Interiors document window.

• Drag a folder containing plug-ins into the Tools palette. All the plug-ins in the folder w
be loaded.

• Drag a folder containing plug-ins into the main Interiors window. All the plug-ins in th
folder will be loaded.

Note : When a plug-in, for example the Furnishings tool, is dragged and dropped into the 
palette or document window, a furniture item is not added to the document, the furnishing
is just added to the Tools palette.

◆ Working Efficiently

If your computer has over 32 Mb of memory, you may want to increase the amount of RA
allocated to  Interiors by 1024K (1Mb). This will allow you to drag and drop large sounds
tures, and background pictures into your documents. 

Note:  Apple’s QuickDraw 3D uses available free system memory to perform its functions
Therefore, you will need at least 1 Mb of free memory after Interiors has been launched.
find out how much memory is available, click on the desktop, pull down the Apple menu 
select About This Macintosh. The largest unused block section of this dialog represents 
amount of free memory. 
1-6
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◆ Help

Balloon Help is available for menu items. Select Show Balloons in the Help Menu, and m
the cursor over items in the Interiors’ menus to display balloons containing help message
Select Hide Balloons if you do not wish the help information to display.

If you are using ATI QuickDraw 3D Accelerator Hardware, see the following section for h
dealing with any problems.

Interiors Online Manual

The online manual is included on the Interiors CD in pdf format. It will be placed in the In
ors 3.1 folder during the installation process. To access the online manual, launch Interio
select Interiors Online manual from the help menu. A table of contents will display, allow
you to easily navigate through the pdf documents making up the complete manual.

◆ ATI QuickDraw 3D Accelerator Hardware 

Many of the most recent Macintosh computers, such as the 6500 and G3 series, include
QuickDraw 3D accelerator hardware chips on the computer’s motherboard. The ATI Quic
Draw 3D Acceleration hardware can also be purchased in the form of a PCI card to use in
Macintosh computer. These ATI hardware products include XClaim 3D, XClaim VR, and R
Pro.

Troubleshooting

QuickDraw 3D hardware acceleration stops due to insufficient VRAM

The ATI QuickDraw 3D accelerator hardware also runs the video, and the hardware’s cap
ities are determined by the amount of VRAM available. If the hardware runs out of VRAM
QuickDraw 3D hardware acceleration will stop working and QuickDraw 3D will revert aut
matically to software rendering.

To increase the amount of VRAM available for QuickDraw 3D acceleration try the followi
1-7
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• Reduce the size of the largest Interiors QuickDraw 3D window. If you are working w
multiple windows open, the amount of VRAM used is determined by the largest wind
but smaller windows may still be accelerated.

• Reduce the monitor color depth to thousands of colors.

• Reduce the monitor resolution towards 640 x 480.

• Install more VRAM

Textures do not display

If many textures are used in a document, there may not enough VRAM to store them. In
case the textures will not be displayed when using hardware acceleration.

Try the following solutions:

• Increase the texture compression setting in the ATI control panel.

• Increase the amount of VRAM available using one of the methods listed above.

• Turn off hardware acceleration in the Renderer Options palette. Software rendering 
real RAM to hold the textures.

Transparencies do not display

Transparency is a function of hardware acceleration and will not be seen if hardware acc
ation is not running.

Try the following solutions:

• Check that hardware acceleration is turned on in the Renderer Options palette.

• Increase the amount of VRAM available using one of the methods listed above.
1-8
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◆ Technical Support

You must register your product in order to receive technical support, as well as upgrade 
new product information. In North America, South America and the Far East, please con

Microspot USA, Inc.
1756 Costa del Sol
Boca Raton, FL 33432
USA

Technical Support: (561) 395-9704; International: + 1-561-395+9704
FAX: (561) 395-9941; International: + 1-561-395-9941

Email: support@microspot.com
Web Pages: www.microspot.com

In Europe and other parts of the world, please contact:

Microspot Limited
Concorde House
10-12 London Road
Maidstone
Kent
ME16 8QA
England

Phone: 01622-687771; International: + 44-1622-687771
FAX: 01622-690801; International: + 44-1622-690801

Email: support@microspot.co.uk
Web Pages: www.microspot.co.uk
1-9
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Chapter 2

Tutorial

A brief introduction to some of Interiors features and tools.
Table of Contents
Getting Started 2-3

Launch Interiors 2-3
The Tools Palette 2-4
Setting the Grid Options 2-4
Resize the Window 2-5
Save the Document. 2-5

Drawing Room Walls 2-5
Set the Wall Options 2-5
Draw the Walls 2-6
Change to the Top View 2-10
Rotate the Grid 2-10
Save the Document 2-10

Add a Floor 2-11

Add Windows and Doors 2-12
Select Windows & Doors Tool 2-12
Changing the View 2-13
Adding a Door 2-14

Add Windows and Doors cont…
Position the Door 2-16
Add a Window 2-16
Save a View 2-21
Add Curtains 2-22
Rendering Speed 2-24

Add Furniture 2-25
Autogrid 2-25
Add a Sofa 2-26
Use the Nudge Palette 2-27
Latching Options 2-30
Add a Fireplace 2-30
Add Remaining Furniture 2-32

Lighting 2-35
Wall Lights 2-35
Sun Light 2-36
Lights Palette 2-37
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Colors and Textures 2-38
Add Colors 2-38
Add Textures 2-38
Adjusting Textures 2-39
Add Textures to Object Parts2-41

Add a Ceiling 2-44

Adjust Lighting 2-45

Look Around 2-46

Final Render 2-47

Take a Picture or Print 2-48
Take a Picture 2-48
Print 2-49

Summary 2-49
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The following tutorial takes you through the process of designing an irregularly shaped r
and placing doors, windows, furniture, accessories and lighting objects within it. Colors a
textures are then applied to the walls and furniture, and the various light settings are adju
create a realistic scene. A final render is then produced and a picture saved and/or printe

Once you are familiar with the tools and methods discussed here, you can easily use the
design and make-over your own rooms, so interior design is effortless, risk free and fun!

◆ Getting Started

Launch Interiors

Double-click on the Interiors icon to launch the application. A new untitled document will 
play along with the Tools and Help palettes and the application menu bar:

Note:  By default the document will contain a point light positioned above the centre of the
to provide some initial lighting. For this tutorial leave this light in place; when working wit
other files it can be deleted if not required.

Tools Palette

Help Palette

Menu Bar

Document Window
Document Name Document View

Document Grid

Zoom Out
Zoom In

Change View Popup Menu
2-3
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The Tools Palette

Familiarize yourself with the tools available in the Tools palette. Click on a tool (other tha
top four tools) and hold down the mouse button to display the name of that tool. Look at
Help palette for brief advice on using the selected tool.

Note:  The window view may change and various palettes open according to the tool sele
When you have finished looking at the tools available, select the Arrow tool, close all pal
except for the Tools and Help palettes (by clicking on the palette’s top left corner), and s
Home View from the Change View submenu in the View menu.

Setting the Grid Options

Before beginning to design your room, you must first specify the drawing environment. G
the Options menu and ensure that there is a checkmark next to the Metric option. If there
select Metric from the menu to specify that metric units of measurement should be used

Select Grid Options from the Options menu set the Grid Options as shown below and cl
OK:

Arrow

Rectangular Marquee

4 Walls

Windows & Doors

Light Director

VR

Take Picture

Rotate

Hand

Walls

Furnishings

Sun Direction

Gravity

Print
2-4



    

d, 

    

 a loca-

   

rectan-
om 

  

 dia-
ettings 
See Grid Options on page 3-37 for more information.

Resize the Window

If you wish to change the window size, click on the bottom right corner of the window an
with the mouse button held down, drag to make the window smaller or larger.

Note:  The smaller the window size the faster the view is rendered.

Save the Document.

Select Save from the file menu to save the document. In the dialog that displays, specify
tion to save the file and give it the name Tutorial A.

◆ Drawing the Walls of the Room

We are going to draw a room that includes a chimney breast and bay window. To draw a 
gular room with just four walls you would use the 4 Walls tool, to draw this less regular ro
we will use the Walls tool:

Set the Wall Options

Hold down the Option key (alt/ ) and click on the Walls tool to display the Wall Options
log. Enter 100 as the Wall thickness and 2300 as the Wall height. These are the default s
that will be used for any walls drawn until these settings are changed again. Click OK.
2-5
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Draw the Walls

Below is a plan showing the dimensions in millimeters of the room we are going to draw

1. Select the Walls tool in the Tools palette. The document view changes to an ortho
plan view as this is the easiest view to use when drawing walls.

See Camera on page D-22 for more details of orthogonal/perspective views.

2. Click towards the top left of the grid then move the cursor to the right to draw the b
wall. The wall is shown as you move the cursor. Constraining lines will display as w
can only be drawn parallel to the grid.

4000mm

1500mm

500mm

1500mm

500mm

1500mm

750mm

1000mm
2000mm

1000mm

1250mm

4500mm
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3. When you think the wall is about the right length, click again. The Edit options dial
will display. The height and thickness of the wall are determined by the values you
entered in the Wall options dialog. Enter a value of 4000 in the Length field and cli
OK.

4. The first wall is drawn on the grid. Move the cursor down to draw the second wall. 
straining lines will display as walls can only be drawn at right angles to each other
2-7
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5. Click again to mark the approximate position of the end of the second section of w
The Edit options dialog displays again. Enter 1500 as the Length and click OK.

Continue in this way to draw the remaining walls referring to the plan shown at the
beginning of this section for the wall measurements.

Note the following:

• If you make any errors press the Delete key ( ) to undo the last wall section dr

• To avoid displaying the Edit Options dialog hold down the Option key (alt/ ) wh
clicking to mark the end point of a wall.

• When you are drawing a wall you can easily see when the end of the wall aligns
another wall as an alignment line will display and the cursor changes to a hollow
cross:
2-8
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6. When you have drawn the final wall click Done in the Edit Options dialog.

7. The view will return to the view displayed prior to the selection of the Walls tool. Th
walls will be drawn as specified and placed in the centre of the grid.

Note:  If you forget to click Done in the Edit Options dialog when you have drawn the final
wall, press the Delete key ( ) to delete the last wall, and then draw it again.
2-9
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Change to the Top View

Select Top View from the View popup menu at the bottom of the document window, or fro
the Change View submenu in the View menu, to display a top view of the document:

Rotate the Grid

Select the Rotate tool in the Tools palette, click on the grid and drag while holding down
mouse button. This allows you to rotate the grid so that you can look at the room you ha
drawn.

Note:  Hold down the Shift key ( ) when rotating the grid to constrain it to its initial plane

Return to the Home View by selecting its name in the View popup menu at the bottom of
document window or from the Change View submenu in the View menu.

See Manipulating The Grid on page 4-10 for more information.

Save the Document

Select Save from the File menu or press Command-S ( -S/ -S) to save the documen
2-10
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◆ Add a Floor

1. With the Arrow or Rotate tool selected click on a wall to select it

Note:  When an object is selected it is surrounded by a bounding frame with handle
the points where the bounding lines intersect. (As you are inside the room, the bou
frame may not be visible in this instance.) See Select/Move on page 4-4 for more info
mation.

2. Choose Floors from the Plug-in menu.

3. A floor will be added to the room:

Note:  Floors are drawn in such a way that they can only be seen from above. If yo
rotate the grid and view the room from below, the floor will be invisible, although th
floor object is still present.

Save the document.
2-11
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◆ Add Windows and Doors

Selecting the Windows and Doors Tool

Click on the Windows and Doors tool in the Tools palette.

The Windows and Doors palettes and the NaviCam palette will display. Click on the title b
a palette and drag, holding down the mouse button, to reposition it.
2-12
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The window view will change to show a view from the middle of the room. The camera is
placed inside the room looking towards the back wall:

Changing the View

To change the view to show the wall in which we want to place the door, we will use the 
NaviCam palette:

The red square displayed in the palette, both in the height area and in the position plan, 
sents the camera. The line from this square shows the camera view direction and at the 
this line is the look at point or point of interest.

• In the Position Plan, click on the camera square and drag to change the position of t
camera. Click on the view direction line and drag to change the view direction.

Height Area
Position Plan

Zoom Position Buttons

Grid Height
2-13
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• In the height area move the camera up or down to change the camera height or mov
view direction line to look up or down.

• If necessary, click on the Zoom button and drag up or down to zoom in or out of the s

For more information about using the NaviCam palette please see NaviCam on page D-

Using the above controls change the camera position and view direction so that you are
ing at the farthest end of the left wall:

Adding a Door

Click on the Doors button in the Windows and Doors dialog. The Libraries palette will op
displaying the Doors library:

See Libraries on page D-9 for more information about the Libraries palette.
2-14
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Click on a picture of a door to select it and display its name in the field at the bottom left o
palette:

Click on the Panelled Door, hold down the mouse button and drag the cursor over the le
of the room. Release the mouse button to drop the door on the wall. The door will be pla
the wall and the Windows and Doors palette will show its dimensions and position in the 

Note:  If the Windows and Doors palette is not visible (it may be beneath another palette),
play it by selecting its name in the Palettes menu.

Panelled Door

Width of door
Height of door

Height above floor

Distance from rightDistance from left
end of wallend of wall
2-15
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Position the Door

With the door still selected, enter 200 in the field specifying the distance of the door from
right end of the wall. Press the Enter key ( ). Leave the other dimensions at the defaul
calculated values.

See Windows and Doors on page D-33 for more details about the Windows and Doors p

Add a Window

Use the NaviCam palette to change the view so that you are looking at the front of the ba
dow from inside the room.

Note:  If the NaviCam palette is not visible, select its name from the Palettes menu to disp
2-16
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Click on the Windows button in the Windows and Doors dialog, the Libraries palette disp
the Windows library:

To find a specific window object, type its name into the Find field at the top right of the pa
In this example, type ‘simple sash’. Press the Enter key ( ):
2-17
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The first item with a name staring with ‘simple sash’ is found. Simple Sash Window is sel
and highlighted by a black frame around its preview icon. The selected item’s full name 
plays in the Name field at the bottom right of the palette.

Drag and drop a Simple Sash Window onto the front bay wall. The Windows and Doors p
displays the window’s dimension and position information:

Resize and reposition the window by entering the values shown below into the Windows
Doors palette. Press the Enter key ( ) after entering information in a field.

Note:  When you click in one of the measurement fields in the Windows and Doors palette
enter or change the values, a black arrow shows the dimension that the field relates to.

With the window still selected, choose Duplicate from the Edit menu. A second identical 
dow is placed to the left of the first. Click on the second window, hold down the Shift key 
and drag the window further to the left. Holding down the Shift key ( ) constrains movem
2-18
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to the X, Y or Z axis, so the second window should remain the same height from the floor 
first. Position the second window 150mm from the left side of the bay using the Windows
Doors palette:

Change the view to look at the left side of the bay:
2-19



Add a third window and reposition/resize it as below:

Change the view and place a fourth window on the opposite side of the bay:
2-20
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Save a View

Change the view using the NaviCam palette, positioning the camera near the door and lo
towards the windows. Click on the button marked with a magnifying glass and drag down
zoom out from the scene if necessary:

Select Name View from the View menu. In the Name View dialog, enter ‘From Door’ and c
OK:
2-21
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The view will be saved under this name and can be selected from the Change View pop
menu in the View menu or from the View menu at the bottom of the document window:

Save the document.

Add Curtains

Click on Tied Curtain Open in the Windows Library and drag the curtain over the left han
window in the front of the bay. When the window is highlighted with a bounding frame, rel
the mouse button to drop the curtain:
2-22
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Select the arrow tool. If the view changes, select From Door in the Change View submen
the view menu to reset the view displayed. Click and drag on the left hand curtain to posi
next to the left wall of the bay. With the curtain still selected, choose Gravity from the Plu
menu to position the curtain on the floor:

Still using the arrow tool, click on the object handle at the top right of the curtain and, ho
down the mouse button, drag to resize the curtain to a suitable height and width:

See Select/Move/Scale on page 4-7 for more information about resizing objects.

With the curtain still selected, choose Duplicate from the Edit menu. A second pair of ide
curtains are placed to the left of the first pair. Carefully select the second pair of curtains
2-23
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clicking on the right-hand curtain, hold down the Shift key ( ) to constrain movement to
X, Y or Z axis, and drag to place the second pair of curtains over the right-hand window.

Using the NaviCam palette to change the view (select the NaviCam palette from the Pal
menu to display it if necessary), and the arrow tool to move and resize the objects, add c
to the side windows of the bay.

Note:  If you make a mistake at any point select Undo from the Edit menu or press Comma
( -Z/ -Z) to undo the last action.

See Undo on page 3-14 for more information.

Save the document.

Rendering Speed

Depending on the speed of your computer, you may notice that some objects are simplifi
being turned into cubic objects. This is a function of the Construct Idler plug-in which is tu
on by default. When rendering speed falls below 4 renders per second the plug-in starts
plify the objects in the scene that contain the most triangles by turning them into cubes. 
allows you to continue to edit a complex document in real time, even on one of the slowe
computers. Any selected items, windows and doors are not affected by this process and
are redrawn in full once the editing action is complete. To turn the Construct Idler off, sele
name in the Plug-in menu.
2-24



view:

ove 

n this 
ions 
◆ Add Furniture

The next stage is to furnish your room.

Select the Furnishings tool in the Tools palette. The document view will change to a top 

The Furnishings palette displays and also the Nudge palette which allows you to easily m
and rotate items. Reposition the palettes on the screen as necessary.

Autogrid

Autogrid applies an invisible grid to the document to which object points can snap. It is 
enabled by default to make it easier to align objects. The distances between the nodes o
grid are determined by the value entered for the Snapping Grid Distance in the Grid Opt
dialog.
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When a check mark appears next to its name in the Options menu, the Autogrid option i
As we do not need Autogrid in this example, select its name in the Options menu to turn
option off.

See Autogrid on page 3-36 for more details.

Add a Sofa

Click on the Chairs button in the Furnishings palette. The Libraries plug-in displays the C
library:

Find the ‘Curved Back Sofa’ by typing its name in the Find field in the Libraries palette a
pressing Enter ( ). Click on the sofa icon and hold down the mouse button, move the c
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over the floor of the room and when the floor is highlighted release the mouse button to 
the sofa onto the floor:

Either select the arrow tool and click and drag on the sofa to move it, or use the Nudge p
to move it by a specified amount.

Use the Nudge Palette 

Select the sofa in the document window.

Enter a value in the Move box in the Nudge palette. The units will be millimeters as set fo
document at the beginning of the tutorial.

Click on the control buttons to choose the direction in which to move the selected object
direction relates to the current view.

Note:  You will not be able to move the sofa closer or further away (when looking at a top v
as it is constrained to stay on the floor. See Lock Position on page 4-17 for more details.

Move Up

Move Down

Move Left Move Right

Move Closer Move Further Away
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Position the sofa on one side of the chimney breast:

Drag and drop a second sofa onto the floor of the room:

Use the Nudge palette to rotate the sofa:

1. Select the sofa in the document window.

2. Enter a value of 180° in the Rotate box in the Nudge palette.
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3. Click on the Rotate Clockwise button to rotate the second sofa to face the first. (T
direction of rotation relates to the current view).

Note:  You will not be able to rotate the sofa other than clockwise or anticlockwise (when l
ing at a top view) as it is constrained to stay on the floor. See Lock Rotation on page 4-18 for 
more details.

Rotate Up

Rotate Down

Rotate Left Rotate Right

Rotate Anticlockwise Rotate Clockwise
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Latching Options

From the Palettes menu, select the Cursor Options palette. Set up the dialog as below t
close the palette.

Latching is the alignment or snapping of points with other points. When positioning objec
latching lines will display (and sounds may play) when the latching points of the selected
objects are aligned or snapped to the latching points of unselected objects. See Cursor Options 
on page D-7 for more details.

With the arrow tool selected, click on the second sofa and drag it until latching lines disp
show that it is directly opposite the first sofa. Drag the sofa along the latching lines to po
it on the opposite side of the chimney breast to the first sofa. Release the mouse button

Add a Fireplace

Select Misc Furniture from the Display menu in the Libraries palette. A library of miscella
neous furniture items displays:
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Find the Fire Place and drag and drop it onto the right wall of the room. (Ensure that the walls 
rather than the ßoor are highlighted before releasing the mouse button. ) As the fireplace was 
dropped onto the wall, it will be positioned against the wall:

With the fireplace still selected, choose Gravity from the Plug-in menu to position the firep
on the floor.

Open the Info Palette by selecting Info from the Palettes menu:

Select the fireplace again if necessary, type 1500 in the X Size field in the Info Palette and
the Enter key ( ). The fireplace is resized so that it is 1500mm long, which is the same s
the width of the chimney breast.

See Size on page 4-17 for more information about the resizing objects using the Info pal
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From the Palettes menu, select the Cursor Options palette to open this palette again. Tu
latch Hot Spots:

Turning on Latch Hot Spots specifies that an objects ‘Hot Spots’ should be activated as 
ing points. Hot Spots are points in addition to the corners and mid points of an object’s boun
ing box and are automatically added to wall objects at the top and bottom of the wall at e
corner. In this example we need to turn on Latch Hot Spots to enable us to line the firepl
with the corners of the chimney breast.

Select the arrow tool and drag to move the fireplace until latching lines show that it’s bac
ners have snapped to the corners of the chimney breast.

Reposition the sofas if necessary. Note:  you may need to turn off latching to do this.

Add the Remaining Furniture

Use the methods described above, changing the view and turning latching on and off as
sary, add the following furniture and accessories to the room. Note that most items have
entation assigned to them, so will be placed in the room the correct way up. Objects will
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snap to the surface they are dropped on, so ensure the correct object is highlighted befo
releasing the mouse button. Resize items as required.

• Add a rug to the floor between the two sofas. (Blue Rug in the Misc Furniture library.

• Place a coffee table on the rug. (Rectangular Coffee Table in the Tables library.)

• Place a vase on the mantelpiece. (Vase in the Misc Furniture library.)

• Put a picture on the wall above the fireplace. (Picture in the Misc Furniture library.) 
Change the view to show the wall above the fireplace and drag and drop the picture
this surface. Change the view back to a top view.

• Add a radiator to the top wall of the room. (Detailed Wall Radiator in the Misc Furnitu
library.) After dragging and dropping the radiator onto the wall, use Gravity to drop it
the floor.

• Position a chest against the left wall of the room. (Chest in the Bedroom library.) Drag
and drop onto the wall and use Gravity to drop it to the floor.

• Put a plant on top of the chest. (Plant in the Plants library.)

Your room should now look something like this:
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Select Home View from the View popup menu at the bottom of the document window to 
at the scene from within the room:

Save the file.
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◆ Lighting

Wall Lights

Use the NaviCam palette to change the view so that you are looking at the right wall and
see the alcoves at either side of the fireplace (you may need to click on the Zoom button
NaviCam palette and drag down to zoom out):

From the Lighting library, drag and drop an Extended Wall Lamp on to the wall of each al

Zoom Button
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Position the lights so that they are both the same height from the floor using either latch
adjusting the height (Y position value) for each light in the info palette:

Sun Light

Select the Sun Direction tool in the Tools palette:

The Lights palette is displayed and the document view changes to a top view:
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A red line with a handle at the end of it shows the current sun direction. Click on the handle a
drag to adjust the direction of the sun light:

Lights Palette

Experiment with the controls in the Lights palette to see how they affect the scene:

See Lights on page D-16 for more information regarding the Lights palette.

Save the document.
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◆ Colors and Textures

Colors and textures can easily be applied to objects within your room. In this example w
use those provided in the libraries included, but as any pict image can be applied as a te
you can scan actual paper and fabric samples to use in your interior design.

Add Colors

1. Open the Libraries palette if necessary by selecting its name in the Palettes menu

2. Choose Colors from the Display menu to open the Colors library.

3. Click on Blue 40% and, holding down the mouse button, drag the cursor over one 
sofas in the room. When the sofa is highlighted, release the mouse button to drop
color onto it.

4. In the same way drag and drop the same color onto the second sofa.

Add Textures

1. Open the Texture library.

2. Drag and drop the ‘Cloth’ texture onto the rug on the floor of the room.

3. Drag and drop the ‘Sponging Terracotta’ texture onto the walls.
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4. Drag and drop the ‘Wood Boards’ texture onto the floor.

Adjusting Textures

As the texture applied to the floor is much too large, we will adjust it using the Textures pa
This opens automatically when a texture is dragged and dropped onto an object, but can 
opened by selecting its name in the Palettes menu.

1. Select the floor. Its texture is displayed in the Textures palette:

2. Ensure that the Constrain Horizontal and Vertical Scale checkbox is checked on.

3. Click and drag on either the Horizontal Scale or Vertical Scale scrollbar to increas
texture scale to about 6, or enter 6 in the Horizontal Scale or Vertical Scale field.

Scale/Offset Selector Constrain Horizontal
& Vertical Scale
2-39
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Note:  Hold down the Shift key ( ) while dragging on a scroll bar to adjust the scale
whole numbers.

4. The texture on the floor is scaled accordingly:
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5. Click and drag an the Rotation scrollbar to rotate the texture on the floor so that th
‘floor boards’ appear to run up and down the room or type 74° in the Rotation value 
field and press Enter ( ):

6. The texture on the floor is rotated accordingly:

See Textures on page D-28 for more details about the Textures palette.

Adding Textures to Parts of Objects

Sometimes you may wish to apply a color or texture to just part of an object rather than 
whole object. Depending on how the object is constructed, it is usually possible to add co
texture to individual surfaces.

1. Select the fireplace.
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2. Select Dismantleable from the Options menu. This allows an object to be broken 
into its component parts.

3. Select Edit Item from the Options menu. An editing window opens showing only th
fireplace.

4. Select Right and then Look At Selected from the View popup menu. This positions
so that it looks towards the front of the fireplace and places the fireplace at the cen
the view.

5. Open the NaviCam palette and change the view so that you can see the whole fir

6. Select Dismantleable again, then choose Ungroup from the Edit menu. The firepla
broken down into its separate component parts:

Mantelpiece

Fire Surround

Hearth
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7. Choose Select None from the Edit menu to deselect all the objects.

8. Drag and drop the ‘White Marble’ texture onto the surfaces of the fire surround.

9. Drag and drop the ‘Blue Mosaic’ texture onto the surfaces of the hearth.

10. Adjust the textures on each surface as necessary. Note that you will probably nee
uncheck the Constrain Horizontal and Vertical Scale checkbox to adjust the Horizo
and Vertical scales independently:

11. Click on the top left corner of the editing window to close it. The fireplace remains i
original position within the room, but now displays the two new textures applied. 
Change the view using NaviCam to look at the fireplace:

See Dismantleable on page 3-36, Edit Item on page 3-34 and Ungroup on page 3-23 for
information.

Save the document.
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◆ Add a Ceiling

As we have now finished our interior design we can add a ceiling to the room.

1. Click on the walls to select them.

2. Choose Ceilings from the Plug-in menu:

3. An alert displays warning you that it is difficult to place objects in a room once the
ing is in place, and also that ceilings are drawn in such a way that they can only be
from below. If you view the room from above, the ceiling will be invisible, although 
ceiling object is still present. Click OK to close the dialog.
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4. A ceiling is added to the room:

Save the document.

◆ Adjust Lighting

Open the Lights palette if necessary by selecting its name in the Palettes menu.

Adjust the brightness of Spot/Point lights, Ambient light and Sun light, or turn lights off an
to see the effect on your scene.

Set the lighting levels to give the effect you desire for your final render.

See Lights on page D-16 for more details of the Lights palette.
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◆ Look Around

Select the VR tool in the Tools palette:

When the VR plug-in is selected, the NaviCam palette is automatically opened so that yo
also use it to make changes to the camera position and view.

Select the From Door view from the View popup menu then click in the document windo
hold down the mouse button and drag to look around the room using the following contr

• To pan the camera (turn it left and right): drag the mouse left and right.

• To tilt the camera: drag the mouse up and down. The tilt is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the Command key ( /
and drag the mouse left and right.

• To move the camera forwards and backwards: hold down the Command key ( /
drag the mouse up and down.

• To zoom in: hold down the Shift key ( ).

• To zoom out: hold down the Control key.

As you move, the cursor changes to an arrow head pointing in the direction you are mov
all cases, the further you move the mouse from the point first clicked on, the faster the c
will move.

Select From Door in the View popup menu to return to this view again.

Using either the VR Tool or the NaviCam palette, set the view for your final render.

Save the document.
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◆ Final Render

Now that our room is complete and we have chosen a specific view, we can produce a h
quality render.

1. Open the Renderer Options palette by selecting its name in the Palettes menu.

2. Uncheck the Show Grid option so that the document grid is hidden.

3. Hold down the Option key (alt/ ) and select Microspot Renderer from the Rende
popup menu.

4. If you have not already registered the renderer, a dialog displays for you to enter y
name, company details and renderer serial number (REND-XXXX-XXXX-XXXX-
XXXX-XXXX). Enter your details and click OK.
Note:  If you do not enter a renderer serial number, the scene will be rendered but 
have a demo panel across it. You can enter a serial number at a later time by click
the Options button in the Renderer Options palette.

5. A dialog displays any options available for the Microspot renderer. Click OK.
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6. The scene will be rendered at a higher quality. Status information displays in the H
palette.

7. Experiment with the lighting controls in the Lights palette and the Renderer Option
see how they affect the quality and realism of the render produced.

Note:  Always reselect the Interactive Renderer in the Renderer pop-up menu in the Rend
Options palette before making any changes to your scene or view.

See Appendix I — Microspot Plug-in Renderer on page I-1 for more details.

◆ Take a Picture or Print

Now that the final render has been produced we can take a picture and/or print the wind
view.

Take a Picture

To save a pict image of the window view at 72 dpi, click on the Take Picture plug-in in th
Tools palette:

The cursor changes to a camera. Move it over the document window and click. The stan
Save dialog displays. Enter a name for and location to save the pict image and click OK t
the image.

This picture file saved can be opened with any application that supports PICT e.g. Simp
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Print

To print the document view, select the Print tool in the Tools palette:

The cursor changes to a printer. Move it over the document window and click. The stand
Print dialog displays. Enter the required number of copies etc. in the Print dialog and clic
to print the view.

◆ Summary

This tutorial should have given you a good idea of the capabilities of Interiors and explain
how to use many of the features. Please refer to the reference part of the manual to exp
many more advanced features available.
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Chapter 3

Menus

Details of the application’s File, Edit, View, Options, Palettes, Plug-in and
Help menus. Command key shortcuts can be used to perform many menu
commands. See Appendix L — Command Key Table on page L-1 for details.
Table of Contents
Apple Menu 3-3

About Interiors 3-3
About Plug-ins 3-4

File Menu 3-6
New 3-6
Open 3-6
Insert 3-7

Add as Object 3-7
Add to Object 3-8
Fore/Background Picture 3-9

Import 3-10
3DMF 3-10

Export 3-11
3DMF 3-11

Close 3-12
Save 3-12
Save As 3-12

File Menu continued…
Revert 3-13
Page Setup 3-13
Print 3-13
Print One 3-13
Quit 3-13

Edit Menu 3-14
Undo 3-14
Cut 3-14
Copy 3-15
Paste 3-15
Paste Special 3-15

Add as Object 3-16
Add to Object 3-17
Fore/Background Picture 3-18

Clear 3-19
Select All 3-19
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Edit Menu continued…
Select None 3-20
Duplicate 3-20
Group 3-22
Ungroup 3-23
Preferences 3-24

Color Preferences 3-24
Default Tool 3-25
Options 3-25

Show Clipboard 3-26
Camera 3-27
Viewing Tools 3-27

View Menu 3-29
New Window 3-29
Close Window 3-29
Name View 3-30
Delete View 3-30
Change View 3-31

Look at Selected 3-32
Home View 3-32
Custom 3-32
Top, Front, Left,
    Right and Back 3-33
Last View 3-33

Open Documents 3-33

Options Menu 3-34
Edit Item 3-34
Lock 3-35
Unlock 3-36
Primitive 3-36
Dismantleable 3-36
Autogrid 3-36
Grid Options 3-37
Metric 3-38
Inches 3-38
Spin Around Look At 3-38

Palettes Menu 3-39

Plug-in Menu 3-40

Help Menu 3-41
About Balloon Help 3-41
Show/Hide Balloons 3-41
Online Manual 3-41
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APPLE MENU

Click on the Apple icon at the top left of the screen to display the Apple menu. The top tw
items relate to Interiors:

◆ About Interiors

Select About Interiors to display the About Interiors dialog. This provides information abo
the version of the application and QuickDraw 3D you are running, registration and serial
ber details.
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◆ About Plug-ins

Select About Plug-ins and hold down the mouse button to display the list of the plug-ins 
are currently running:
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Select a plug-in name from the list to display a dialog containing brief details about the pl
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FILE MENU

◆ New

Opens a new, untitled document.

If there is a document called Default Stationery Pad located in the same folder as the ap
tion, a copy of this document will be opened as an untitled document (a document is tag
a stationery pad via the Get Info dialog). This allows you to use the same customized se
for each document.

◆ Open

Opens an existing Interiors file, or any other file created by a QuickDraw 3D-compatible 
cation.

Select Open and a standard dialog displays for you to select the file to open.
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◆ Insert

Select Insert to bring QuickDraw 3D, picture, or text files into documents.

When the standard dialog displays, select a file to insert. The Insert Dialog will display:

The options available will depend upon the type of file selected, and whether an object w
selected when Insert was chosen. The type of file selected will be indicated on the left si
the dialog.

Add as Object

The selected file appears either in the center of the grid or at the last place the mouse w
clicked.

• QuickDraw 3D Þle:  Appears as a 3D object, the orientation of which will depend on th
information contained in the QuickDraw 3D file.
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• Picture Þle:  The image displays as a rectangle with the same proportions as the origi
picture. The longest side of the rectangle is equivalent to the length of one side of on
square and its orientation relates to the grid.

• Text Þle:  Text is placed in the document as a text marker. The marker has a specific l
tion within the document, but the text is always displayed perpendicular to the came
regardless of the view.

Add to Object

This option is only available if an object was selected in the document before Insert was
sen. The file is converted to a picture (if necessary) and applied to the selected object a
ture. The properties of the selected object will determine how it is applied.

Available for:

• QuickDraw 3D Þle
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• Picture Þle

• Text Þle

Foreground/Background Picture

The file is converted to a picture (if necessary) and placed in the foreground/background 
it remains even if the view changes. If the proportions of the image are not the same as t
portions of the window, the image is distorted to fit the window. Its size remains constant
tive to the window size.

Available for:

• QuickDraw 3D Þle

• Picture Þle
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◆ Import

The Import submenu allows you to access Import options.

Open the file menu and select Import. A submenu lists the Import options. Select the op
you wish to use from the list.

3DMF is the only Import option that is part of the application. All other Import options are
plug-ins. See Appendix A — Import Plug-ins on page A-1 for further details.

3DMF

Select 3DMF and the following dialog displays:
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As 3DMF is the native file format of the application, you can import 3DMF objects by

• Using the Insert command. See Insert on page 3-7 for details.

• Opening a 3DMF document and dragging and dropping items from the new docume
the current document. See Open on page 3-6 and Appendix J — Drag and Drop on pa
1 for details.

• Dragging and dropping a 3DMF file from the Finder into the document. See Appendix J —
Drag and Drop on page J-1 for details.

◆ Export

The Export submenu allows you to access Export options.

Open the file menu and select Export. A submenu lists the Export options. Select the op
you wish to use from the list.

3DMF is the only Export option that is part of the application. All other Export options are
plug-ins. See Appendix B — Export Plug-ins on page B-1 for further details.

3DMF

Select 3DMF and the following dialog displays:

As 3DMF is the native file format of the application, you can export 3DMF objects by
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• Using the Save or Save As command. See Save on page 3-12 and Save As on page 3-12
further details.

• Dragging and dropping items from the document to the Finder or another application
supports 3DMF and Drag and Drop. See Appendix J — Drag and Drop on page J-1 for
details.

◆ Close

Closes the current document and its associated windows. If the document has not been
or if changes have been made to it since it was last saved, an alert will display asking if 
want to save the document before closing.

◆ Save

The Save option is only available if a document has never been saved, or if changes hav
made to it since it was last saved. Using the Save option saves the document in 3D meta
mat. If the document has not been saved before, a dialog will display for you to specify t
document name and a location to save it.

To save a document as a stationery pad, give it the name Default Stationery Pad. The do
will be automatically tagged as a stationery pad. See New on page 3-6 for information about
opening the Default Stationery Pad.

◆ Save As

Choose to save a document (in 3D metafile format) under a different name or in a differe
location. If you try to save a document in the same location as a document of the same 
an alert will ask if you wish to replace the existing file.
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◆ Revert

Returns to the last saved version of a document. (This option will only be available if the 
ment has been previously saved.) An alert will display to ask if you are sure you wish to 

◆ Page Setup

Select to display the Page Setup dialog. The options available in the Page Setup dialog 
depend on the printer driver you have selected in the Chooser.

◆ Print

Select to display the Print dialog. The options available in the Print dialog will depend on
printer driver you have selected in the Chooser.

◆ Print One

Prints one copy of the current window without displaying the Page Setup and Print Dialo

◆ Quit

Quits the application and closes all open files and their associated windows. If any open
have been changed without being saved, a dialog will display asking if you wish to save 
changes.
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EDIT MENU

◆ Undo

Allows you to undo your last object manipulation. Selections, de-selections and view cha
are not object manipulations, and therefore cannot be undone.

This option will be disabled if no document is open, if an open document has not been ch
since it was last saved, or if Do Undos has been turned off in the Preferences dialog. See Do 
Undos on page 3-25 for further details.

After an object manipulation has been undone, the Undo option will change to Redo. Se
Redo to perform the action again.

◆ Cut

Removes a selected item from the current document and places it on the clipboard whe
remains until replaced by another item cut or copied from the document.
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◆ Copy

Copies a selected item from the current document and places it on the clipboard where 
remains until replaced by another item cut or copied from the document.

◆ Paste

Pastes items into the current file either in the center of the grid or at the last place the m
was clicked. 3DMF, PICT, text, and sound files can be pasted into Interiors documents. 3
data are pasted in as 3D objects; PICT files are pasted in as rectangles; text and sound 
pasted in as markers.

◆ Paste Special

Paste Special is only available if you have cut or copied items from an application other 
Interiors. When you select Paste Special, the following dialog displays:

Items cut or copied from other applications can be placed in Interiors documents in a vari
ways, depending on their formats. If you have cut or copied multiple data types, you can
the list on the left of the Paste Special dialog to select the data type you want to place in
document.
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The Paste Special options available to you will depend on the type of file selected, and w
an object was selected prior to choosing Paste Special.

Add as Object

The file will appear either in the center of the grid or at the last place the mouse was clic

• 3D Object:  Appears as a 3DMF, the orientation of which depends on the information 
tained in the 3D object file.

• Picture:  The image displays as a rectangle with the same proportions as the original
ture. The longest side of the rectangle is equivalent to the length of one side of one 
square, and its orientation relates to the grid.
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• Text/Sound:  Placed in the document as a text/sound marker. The marker has a speci
location within the document, but always displays perpendicular to the camera, rega
of the view.

Add to Object

This option is only available if an object was selected in the document prior to choosing 
Special.

Available for:

• 3D object:  The file is converted to a picture and applied to the selected object as a te
The properties of the selected object will determine how it is applied.

• Picture:  The file is applied to the selected object as a texture. The properties of the se
object will determine how it is applied.

• Text:  The file is converted to a picture and applied to the selected object as a texture
properties of the selected object will determine how it is applied.

• Sound:  The sound is applied to the selected object as an attribute. To play the sound
on the object.
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Foreground/Background Picture

The file is converted to a picture (if necessary) and displayed in the document foregroun
background where it remains even if the view changes. If the proportions of the image a
the same as the proportions of the window, the image is distorted to fit the window. Its si
remains constant, relative to the window size.

Available for:

• 3D object

• Picture

• Text
3-18
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◆ Clear

Use the Clear command to remove items or attributes without placing them on the clipbo
The six options in the top part of the popup menu are only available if an item is selected 
the document before Clear is chosen.

Select the appropriate option to clear the entire object, or a specific attribute of the objec
entire object can also be cleared from a file by dragging and dropping it into the trash ca
Although the object will be removed from the file, a clipping will remain in the trash can u
it is emptied. This allows you to drag and drop the item back into the document if necess

The last three options in the Clear menu allow you to remove the document’s backgroun
color, background picture and foreground picture.

◆ Select All

Selects all of the objects in the current window.
3-19



s unre-

 right 
◆ Select None

Deselects all of the selected items in the current window.

◆ Duplicate

When an object is duplicated, the duplicate is created as an entirely separate item and i
lated to the original.

1. Select an item or group of items and choose Duplicate.

2. A duplicate of the selected item or group of items is placed one grid square to the
of the original:
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3. Move the duplicate and choose Duplicate again.

4. The second duplicate will be positioned in the same position relative to the first du
cate, as the first duplicate was to the original:

Any rotations that are applied after the first duplication are also applied to subsequent du
cated items. This is useful for drawing items like spiral staircases.

Hold down the Shift key when using the Duplicate option to avoid applying any offset.
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◆ Group

Groups two or more objects and allows them to be manipulated as a single object.

1. Select the desired items, then choose Group. Grouped items will be surrounded b
bounding rectangle or sphere depending on whether the arrow or rotate tool was u
select them:

2. Double-click on the group or choose Edit Item from the Options menu to open a n
window containing only the items within the group:
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3. Manipulate these items individually, then close the window to view your changes in
original document:

While a Group window is open, the handles of the bounding rectangle or sphere around 
original grouped items will change color. This indicates that the objects are selected, and
Group window is open. The color of the handles is set in the Preferences dialog. See Color 
Preferences on page 3-24 for further details.

If the grouped objects have been placed in further groups, the Group window will contain
grouped objects. Double-clicking on these groups will open additional windows showing 
contents of their respective groups.

If a group of objects is flagged as Primitive, it is not possible to edit the items within the g
by double-clicking on the group or choosing Edit Item from the Options menu. The group 
be flagged as Dismantleable before the individual items can be edited. The Primitive and
mantleable options are available in the Options menu and the Info palette, and are discu
further in the sections Primitive on page 3-36, Dismantleable on page 3-36 and Primitive/D
mantleable Flag on page 4-18.

◆ Ungroup

Ungroups selected items so that members of a group can be selected individually. Note th
option only ungroups one level at a time.

If a group is flagged as Primitive, the Ungroup option will be grayed out in the Edit menu
will not be selectable. The group must be flagged as Dismantleable before it can be ungr
The Primitive and Dismantleable options are available in the Options menu and the Info 
ette, and are discussed further in the sections Primitive on page 3-36, Dismantleable on page 
36 and Primitive/Dismantleable Flag on page 4-18.
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◆ Preferences

Select Preferences to display the Preferences dialog:

Color Preferences

To change color preferences, click on a color square to display the Color Picker. Select 
color and close the Color Picker.

• Handle Color:  The color of the handles on the bounding frame of a selected object.

• Open Handle Color:  The color of the handles on the bounding frame of a group of obje
when an Editing or Group window is open.

• Locked Handle Color:  The color of the handles on the bounding frame of a locked obj

• Light Marker Color:  The color of the cone or point marking the position of a Spot/Poin
Light. If this color is set to white, the color of each light marker will be the same as th
color of the light.

• Grid Color:  The color of the grid.

• Background Color:  The color displayed in the background of a new file.
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• Default Color:  This is the color that displays in the color block in the window toolbar a
is used to draw new objects.

Default Tool

Choose either the Arrow or Rotate Tool as the default tool.

Options

• High Resolution Printing:  Click to print at printer resolution rather than screen resoluti

• Sound On:  Click to play sounds within the application.

• Dynamic Updates:  If this option is enabled, all open windows for a particular documen
will automatically be updated as objects are created or manipulated in the active win
and as slider bar controls in palettes are changed. If this option is not enabled, only 
active window will be updated as actions are performed. Other open windows will no
updated until the action is complete and when moving slider controls, views will not 
updated until the mouse is released.

• Solid Grid:  Click to specify that the document grid should appear as a solid floor rath
than a wire frame grid.

• Global Lights:  When this check box is enabled, the controls in the Lights palette relat
the document. When it is not enabled, the controls in the Lights palette relate to the 
window only.

• Advanced Handles:  When this option is checked on, the lines of the bounding frame o
object can be clicked on and dragged to resize the object. The default setting is off.

• Auto Hide Plug-in Palettes:  When this option is checked on, whenever a plug-in tool is
selected in the Tools palette, any plug-in palettes currently open are closed. This he
prevent your work space from becoming too cluttered.

• Do Undos:  The Do Undos checkbox is used to specify whether or not you wish to be 
to use the Undo command. It is checked on by default.

To be able to perform an Undo command, the application must store a copy of the d
ment (or parts of it) before carrying out any action that will change the document. Th
means that you could need twice as much memory to be available for the application
document itself requires. It also means that for large documents, the time it takes for
application to store the copy of the file may result in unacceptably slow updates as yo
your document. Unchecking the Do Undos checkbox will therefor allow the applicatio
use less memory and also speed up the updating of large documents.
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• Undo Time-out:  As an alternative to completely disabling the Undo command, you ca
leave the Do Undos checkbox checked on, and enter a value in seconds in the Undo
out field. This specifies the amount of time that you are prepared to give the applicat
store a copy of the document. If a copy of the document cannot be stored in the time
ified, no copy will be saved and the Undo command will not be available. The defau
ting of 0 seconds gives unlimited time.

• Edges to a Circle:  Enter a value for the number of sides a circle should have. This will
affect the appearance of circles, spheres, cylinders, etc. The lower the value, the co
the curve. The higher the value, the more memory and disk space you will need to d
and store the images. The default value is 24.

◆ Show Clipboard

Choose this option to display the clipboard, which stores items that have been cut or cop
from applications. The contents of the external clipboard can only be displayed if they ca
recognized.

Note:  The clipboard is part of QuickDraw 3D and so may look different or have more or fe
controls depending on the version of QuickDraw 3D you have installed.

Use the controls at the bottom of the Clipboard window to view stored items:

Camera

Distance
Rotate

Perspective

Move
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Camera

Click on the Camera icon and hold down the mouse to display the Camera popup menu

Use the options in the Camera menu to change the view of an item on the clipboard. The
options available will depend on the version of QuickDraw 3D installed.

Viewing Tools

Click on an icon and move the cursor over the item in the Clipboard window. Hold down 
mouse, then click and drag over the item

• Distance:  Use to move closer to, or further away from, an item:

• Rotate:  Use to rotate an item. To rotate the camera around the item, position the curso
the clipboard’s background and drag while holding down the mouse:
3-27



•  Perspective:  Changes the perspective view of an item:

•  Move : Moves an object up, down, left or right:
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VIEW MENU

◆ New Window

Opens a new window for the current document. The new window displays the same view
original window, and is offset from it. Use the Change View menu to change the view in t
new window to display a different view of the same document. See Change View on page 3-3
for further details.

◆ Close Window

Closes the current window. If this is the last open window for a document, the document
also be closed. If you have made changes to the document since it was last saved, an a
plays asking if you want to save the changes. If you save your changes then later reopen
document, the same view as when the document was closed will be displayed. To save 
with a name, use the Name View option before closing the window. See Name View on page 3
30 for further details.
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◆ Name View

Saves the current view. Enter a name for the view in the dialog that displays:

You cannot use the names of the standard views included in the program. If you specify a
that has already been used to save a nonstandard view, an alert displays asking if you w
replace that view.

◆ Delete View

Deletes a saved view. This option is only available when new views have been created a
saved (standard program views cannot be deleted).

1. Select Delete View and a submenu lists the views that may be deleted:

2. Select the name of the view to delete from the submenu and the view will be dele
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3. If you do not select a view from the submenu, the delete view dialog displays show
the views that can be deleted

4. Select the view to delete and click OK.

Note:  If a document window was displaying a view that has now been deleted, the window
remain open as an untitled view.

◆ Change View

Click on Change View to display a popup menu which lists the available views (including
that you have saved). The view in the current window will be indicated by a check mark. M
the cursor down the list to select the desired view:
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The current window will change to reflect your choice. If a standard view has been chan
hold down the Option key and select the name of the standard view to reset it to the defa
standard view.

The view displayed can also be changed via the Command key shortcuts shown in the C
View popup menu above, or through the popup menu in the Window controls. See View on 
page 4-30 for further details..

Look at Selected

Displays a selected object in the center of the window:

Home View

Returns the camera to its initial position (the view displayed when a new file is opened):

Custom

Any nonstandard view, or any view that has not been saved is a Custom view.
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Top, Front, Left, Right and Back

The five standard views that allow you to display the file from the sides and top:

Last View

The view that was displayed in the window immediately prior to the current view.

◆ Open Documents

At the bottom of the view menu is a list of the documents and views that are currently op
The active window has a check mark to the left of its name. Documents that have been ch
since they were saved are underlined. Select a document/window name from the list to m
the active window:
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OPTIONS MENU

◆ Edit Item

Select to edit individual objects within a group.

Double-click on the group, or select the group and choose Edit Item from the Options me
display a new window which contains only the items in the group.
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The items can now be edited individually. As you edit the individual items, the group rem
locked in the original file window, although it will be updated to reflect any changes you m

Hold down the Option key when closing an editing window, and all editing windows for th
file will be closed.

Items and groups can be flagged as Primitive or Dismantleable. If the selected group ha
flagged as Primitive, Edit Item will be grayed out and will not be selectable. Flag the grou
Dismantleable to edit it. The Primitive and Dismantleable options are available in the Op
menu and the Info palette. See Primitive on page 3-36, Dismantleable on page 3-36, and Prim-
itive/Dismantleable Flag on page 4-18 for further details.

◆ Lock

Protects a selected object or group from being changed. A locked object can be grouped
other objects, but cannot be moved, resized or changed. If you group a locked object with
objects, the entire group will be locked.

If you place the cursor over a locked object, it will display as a padlock.

An object or group can also be locked by selecting it and clicking on the large open padl
icon in the top right corner of the Info Palette. See Lock on page 4-19 for further details. 
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◆ Unlock

Select a locked object or group and choose Unlock to remove the protection against cha
An object or group can also be unlocked by selecting it and clicking on the large closed 
lock icon in the top right corner of the Info Palette. See Lock on page 4-19 for further details

◆ Primitive

Specifies that an item or group should be treated as a basic geometry. A basic geometry
be ungrouped, so individual surfaces or items cannot be edited. An alternate method of s
ing an object as a Primitive is to click on the Primitive/Dismantle button in the Info PaletteSee 
Primitive/Dismantleable Flag on page 4-18 for further details.

◆ Dismantleable

Specify that an item or group can be broken down into its component parts. This will allow
to ungroup an item or items and edit individual components as separate items. An altern
method of specifying an object as Dismantleable is to click on the Primitive/Dismantle bu
in the Info Palette. See Primitive/Dismantleable Flag on page 4-18 for further details.

◆ Autogrid

Autogrid applies an invisible grid to the document to which object points can snap. It is 
enabled by default to make it easier to align objects. The distances between the nodes o
grid are determined by the value entered for the Snapping Grid Distance in the Grid Opt
dialog. See Grid Options on page 3-37 for further details.
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When Autogrid is enabled and a new item is drawn, the cursor is positioned on the close
snapping grid intersection. As the object is drawn, the object’s handles snap to the snap
grid’s intersection points. As an object is resized, the object’s handles are positioned on 
ping grid intersection points. When an item is moved, its center point will snap to the sna
grid intersection points.

If Autogrid was disabled when an object was randomly positioned in the file, the item will
moved or resized in increments of the snapping grid distance when Autogrid is enabled.

Reselect the Autogrid option in the Options menu to turn this option off.

◆ Grid Options

Choose Grid Options to display the Grid Options dialog:

• Number of grid squares:  This value relates to the visible grid. Enter a value to specify 
number of grid squares that should make up one side of the grid.

• Grid square size:  This value relates to the visible grid. Enter a value to specify the len
of one side of one grid square.

• Snapping grid distance:  This value defines the invisible snapping grid. Enter a value fo
the length of one side of one snapping grid square. Typically, you will want to give th
snapping grid distance a value that is a fraction or multiple of one document grid squ
3-37
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• Preferred unit size:  This option allows you to select a unit size.

The entries in the popup menu are determined by whether metric or inches has bee
selected in the Options menu as discussed below.

◆ Metric

Select this option to use metric units of measurement. The grid size, position coordinate
dimensions will all be calculated using metric units. 

◆ Inches 

Select this option to use inches or feet as units of measurement. The grid size, position 
nates and dimensions will all be calculated using inches or feet.

◆ Spin Around Look At

Select Spin around Look At to rotate a view around the point at the center of the view. C
anywhere in the window to stop the rotation.
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PALETTES MENU

Click on Palettes in the application menu bar to display a list of available palettes. Selec
palette name from the list to open it.

The Tools, Info and Help palettes are the standard palettes included in the application. Al
palettes are plug-in palettes that can be loaded when the application is launched or whil
running.

See Chapter 4 — Palettes on page 4-1 for details of the Tools, Info and Help palettes, Ap
D — Plug-in Palettes on page D-1 for details of plug-in palettes, and Installing Plug-ins o
page 1-5 for details of installing plug-ins.
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PLUG-IN MENU

Click on the Plug-in icon in the application menu bar to display a list of available plug-ins

Select the plug-in name from the list to open it.

See Appendix C — Menu Command Plug-ins on page C-1 for details of plug-ins accesse
the plug-ins menu.
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HELP MENU

◆ About Balloon Help

Select this option to display information about Balloon Help.

◆ Show/Hide Balloons

Select Show Balloons to display Balloon Help messages. When Show Balloons has bee
selected, this menu item changes to Hide Balloons. Select Hide Balloons to stop displayi
Balloon Help information.

◆ Online Manual

Select this option to launch Acrobat Reader (if available) and display the Online manual.
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Chapter 4

Palettes

The Tools, Info and Help palettes are the standard palettes included in the
application. All other palettes are plug-in palettes that can be loaded when the
application is launched or while it is running. See Installing Plug-ins on page
1-5 for further details.
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INTRODUCTION

To open a palette, select its name from the Palettes menu. The Palettes menu lists of all
available palettes.

The Tools palette displays automatically the first time the application is launched. The st
and position of all palettes is remembered each time the application is opened. To return
ettes and preferences to their default settings, hold down the Command and Option keys
launching the application. Close a palette by clicking on the top left corner of the palette 
dow.

Window controls are displayed at the bottom of each document window and these are al
cussed in this section of the manual.

Note:  If any palette is moved to within 5 pixels of the edge of the screen, the palette will sn
the edge of the screen.
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TOOLS PALETTE

The tools built-in to the application Tools palette are the Arrow, Rotate, Rectangular Mar
and Hand tools.

The rest of the tools are plug-ins that can be loaded when the application is launched or
it is running. See Installing Plug-ins on page 1-5 for further details.

Select the tool to use by clicking on its icon in the Tools palette. After a tool has been use
currently selected tool reverts to being the Arrow tool, unless the default tool is changed 
Preferences dialog. See Preferences on page 3-24 for further details. You can, however, dou-
ble-click on any tool to lock it in so that it will not change after you use it, but will remain 
selected.

◆ Select/Move

Both the Arrow and Rotation tools can be used for selecting and moving objects. You ca
click and drag on the grid with either tool to move the entire scene in the window. See Manipu-
lating The Grid on page 4-10 for further details.

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. See Lock Position on page 4-17, Lock Size on page 4-17
Lock Rotation on page 4-18 and Lock on page 4-19 for more details.

Select

When an object is selected, it is surrounded by a bounding frame with handles at the po
where the bounding lines intersect:

Arrow (a)

Rectangular Marquee (m)

Rotate (r)

Hand (h)
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To temporarily hide an object’s bounding frame, hold down the Option key and click on th
arrow or rotate tool. The item is still selected, but the bounding frame and handles do no
play. To re-display, click on the arrow or rotate tool again.

To add objects to a selection, hold down the Shift key and click on the additional objects
deselect one object in a selection, hold down the Shift key and click on the object. If you
on an object that is part of a group, the entire group will be selected and the bounding fr
will surround all of the items in the group. 

Double-click on a group of objects to open a new window in which the grouped items ca
edited:

When you close this editing window, any changes you have made will be reflected in the
nal document window. You can also edit a group by selecting it and choosing Edit Item fr
the Options menu. See Edit Item on page 3-34 for further details.
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Hold down the Command key and click the mouse to select an object that is behind ano
object. Initially, the foremost object will be selected. The second time you click the mouse
next object back will be selected, and so on:

Move

To move an object, click on it, hold down the mouse button, and drag. Release the mous
ton to place the object in its new location. Hold down the Control key and drag up or dow
move the object closer or further away. If you hold down the Shift key, lines will display s
ing the X, Y and Z axes, and movement will be constrained to these axes: 

Objects can also be moved by entering coordinate values in the Info Palette. See Position on 
page 4-16 for further details.
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◆ Select/Move/Scale

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. See Lock Position on page 4-17, Lock Size on page 4-17,
Lock Rotation on page 4-18 and Lock on page 4-19 for more details.

Select an object with the Arrow tool, it will display surrounded by a bounding frame with 
dles at the corners.

As an alternative to clicking and dragging, you can move an object using the arrow keys
selecting the object and pressing the desired arrow key to move it one pixel. If you hold d
the arrow key, the object will move one pixel at a time until it has moved six pixels. It will t
begin to move at an accelerated rate. To move objects closer or further away, hold down
Control key while using the up and down arrow keys.

To change the size of an object, move the cursor over one of the handles of the bounding
When the cursor changes to a white arrow, click the mouse and drag. The shape or size
object will change to reflect your actions:

Note:  If the Advanced Handles preference is checked on in the Preferences dialog, the li
the bounding frame of an object can also be clicked on and dragged to resize the objectSee 
Preferences on page 3-24 for further details.

Hold down the Shift key when resizing an object to constrain movement to the X, Y, or Z 
or to maintain the objects proportions. Four constraining lines are displayed. The red line
4-7
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sents the X-axis; the green line the Y-axis; and the blue line the Z-axis. The pink line repr
the line along which the object will retain its current proportions: 

If, after resizing the object, you hold down the Option and Shift keys and resize the obje
second time, the pink line will move to a position which allows you to constrain the objec
the proportions it was originally drawn with:

Objects can also be resized via the controls in the Info Palette. See Size on page 4-17 for fur-
ther details.
4-8



tions, 
 

here 

en the 
t your 

nes of 
 

ject 
 

◆ Select/Move/Rotate

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. See Lock Position on page 4-17, Lock Size on page 4-17,
Lock Rotation on page 4-18 and Lock on page 4-19 for more details.

When an object is selected with the Rotate tool, it displays surrounded by a bounding sp
with six handles.

To rotate the object, move the cursor over one of the handles of the bounding frame. Wh
cursor changes to a white arrow, click the mouse and drag. The object will rotate to reflec
actions:

Note:  If the Advanced Handles preference is checked on in the Preferences dialog, the li
the bounding frame of an object can also be clicked on and dragged to rotate the object.See 
Preferences on page 3-24 for further details.

Note:  holding down the Shift key while rotating an object constrains the rotation to 90°.

You can also use the arrow keys to rotate objects. If you hold down the arrow key, the ob
will rotate in 1° increments for 6°, then accelerate to 10° steps. If you hold down the Shift key
while using the arrow keys, you can rotate objects in 45° increments. To tilt an object, hold 
down the Control key and use the left and right arrow keys.
4-9
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◆ Manipulating The Grid

The Arrow and Rotate tools can be used to move and rotate the grid, as well as objects,
ily manipulate your view of a document.

Moving The Grid

Select the Arrow tool and move the cursor over the grid. Hold down the mouse button, th
sor changes to an open hand. Move the cursor up, down, left or right. The grid will move
reflect your actions:
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Hold down the Control key and move the mouse up and down to move the grid closer an
ther away:

Hold down the Shift key when moving the grid to display, and constrain movement to, the
and Z axes:
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Rotating The Grid

Select the Rotate tool and move the cursor over the grid. Hold down the mouse button, t
sor changes to an open hand. Move the mouse up, down, left or right. The grid moves to
your actions:

Hold down the Shift key while rotating the grid to constrain it to its initial plane. It can the
only be rotated in that plane:

Holding the command key down before grabbing the grid will allow you to switch betwee
rotating or moving the grid. 

The arrow keys can be used to move and rotate the grid when nothing is selected in the
ment window. The grid will either move or rotate depending on which tool is currently 
selected. Use the control key to move in the Z dimension.
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◆ Rectangular Marquee 

Select the Rectangular Marquee tool, hold down the mouse and drag out a rectangle to 
one or several objects. (Note that if any part of an object is inside the marquee, that obje
also be selected.)

To add objects to a selection, hold down the Shift key and drag a rectangle around the d
objects. To deselect items, hold down the Shift key and drag a rectangle around selected
You can also add or remove items from a selection by clicking on them with the Arrow to
while holding down the Shift key.

◆ Hand

Use the Hand tool to change the view of the document by altering the position of the cam
When you select the Hand tool, a frame will appear around the contents of the window. A
dle will also appear at each corner of the frame:
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You can either position the view within the frame, or position the frame around the view. 
position the view, click outside the frame and drag the mouse. To position the frame, clic
inside the frame and drag the mouse:

If you are in an elevation or orthogonal view, move the mouse left and right to crab, or up
down to change the camera height.

If you are in a perspective or user defined view, move the mouse left and right to pan the
era, or up and down to tilt the camera. Hold down the Option key and move left and righ
crab, up and down to change the height.
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To zoom in on an object (note that you are not actually moving the camera, but rather na
ing the focus), click on one of the frame handles and drag it in towards the center of the 
dow:

When you select another tool, the window changes to show the view you have chosen:
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INFO PALETTE

The Info palette displays information about, and provides controls for you to adjust, the c
acteristics of a selected object or light.

Select Info from the Palettes menu to display the Info Palette. When it is first opened, on
top section of the Info palette will be visible. To extend the palette and display the Comm
section at the bottom, click on the button on the left in the top right corner of the palette.
reduce the window, click again.

Note:  The controls in the Info Palette will vary depending on whether you have selected 
object or a spot/point light in the document window:

◆ Position

The figures displayed in the X,Y and Z Position boxes are the grid coordinates of the cen
the selected object’s bounding rectangle. If you select items that are grouped together, t
coordinates displayed will relate to the group. If you select more than one item and the i
are not grouped, no coordinates will display. 

 Lock Position

Lock Size

Lock Rotation

Constrain

Lock Object
Primitive/

Lock Surface Color

Lock Reflective Color

Dismantleable Flag

Proportions
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To precisely position an object, type in values for the X, Y and Z coordinates, then press 
The object will move to reflect your entries.

Lock Position

The padlocks next to the position boxes are used to lock the position of an object. The lo
options work the same for groups of objects as for single objects.

Click on the padlock next to the X position coordinate. It will close, which means the obje
in a fixed position on the X axis (in relation to the grid), but can still be moved in the Y an
axes. Any or all coordinates can be constrained. If an object’s position is constrained on 
three axes, it cannot be moved. However, you can still change the object’s size (unless i
also been constrained).

◆ Size

The size boxes display the X,Y and Z dimensions of an object’s bounding rectangle. If yo
select items that are grouped together, the dimensions displayed will relate to the group’
bounding rectangle. If you select more than one item and the items are not grouped, no 
sions will display. To precisely resize an object, type in values for the X, Y and Z dimensi
then press Enter. The object will be resized to reflect your entries.

Note:  Information about the object’s size will be grayed out if you have selected a light as
objects have a constant size which cannot be changed.

Lock Size

The padlocks next to the size boxes are used to lock the size of an object. The lock optio
work the same for groups of objects as for single objects.

Click on the padlocks by the size dimensions to constrain an object’s size. Click on a clo
padlock to open it and unconstrain an object’s size. Any or all size dimensions can be co
strained. If all are constrained, the size cannot be changed. If just one dimension is const
you can change the other dimensions.
4-17
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Constrain Proportions

The Proportional Constrain checkbox to the bottom right of the dimension fields allows y
constrain the proportions of an object. Select an item and click on the checkbox to turn o
portional Constrain.

The item can now be resized or moved, but will always maintain its current proportions.

◆ Rotation

Lock Rotation

To the right of the size controls are additional padlocks for the X, Y, and Z axes that are u
constrain the rotation of an object.

Click on the padlock relating to the X axis. It will close, indicating that the object cannot 
rotated around the X axis (in relation to the grid), although it can still be rotated in the Y a
axes. The rotation of the object can be constrained in any or all of the axes. The X Y and 
are determined by the orientation of the object.

◆ Primitive/Dismantleable Flag

This option is only available when an item or group is selected. A Primitive item cannot b
ungrouped into component items. Click on the button to toggle between Primitive and Dis
tleable. The solid square button represents the Primitive state and the split button the Di
tleable state. An object can also be specified to be Primitive or Dismantleable by selectin
4-18
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Primitive or Dismantleable from the Options menu. See Primitive on page 3-36 and Dismantle-
able on page 3-36 for further details.

◆ Lock

To lock a selected object or group of objects, click on the padlock icon in the top right corn
the Info palette, or select Lock from the Options menu. See Lock on page 3-35 for further 
details. This will prevent the object or group from being moved or changed. To unlock an 
object, click on the Padlock icon a second time, or select Unlock from the Options menuSee 
Unlock on page 3-36 for further details.

◆ Colors

Surface

The Surface color box shows the color of the selected object.

To change the color of the object, click on the Surface color box to display the Color Pick
Select a color and close the dialog. The color you have chosen will be displayed as the S
color and applied to the selected object. If a light is selected the Surface color is the color
light emitted, rather than the color of the light marker, which is set in the Preferences dia
See Color Preferences on page 3-24 for further details. Colors can also be dragged and 
dropped onto the Surface color box from the Default Color block at the bottom of the doc
ment window, from the Reflective color box, the Color Palette etc.

Lock Surface Color

The padlock next to the Surface color box is used to protect the surface color of the objec
being changed.

Reflective

The Reflective color box shows the reflective color of the selected object. If light is shinin
an object (sun light or spot/point lights), the part of the object that shines displays the refl
4-19
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color. This will only be visible if you have selected the Best Shading option for the intera
renderer, or the Microspot Renderer via the Renderer Options palette. See Renderer Options on
page D-21 for more details. This option is not available for lights.

To change the Reflective color of the object, click on the Reflective color box to display t
Color Picker. Select a color and close the dialog. The color you have chosen will be disp
in the Reflective color box. Colors can also be dragged and dropped onto the Reflective
box from the Default Color block at the bottom of the document window, from the Reflec
color box, the Color Palette etc.

Lock Reflective Color

The padlock next to the Reflective color box is used to protect the surface color of the ob
from being changed.

◆ Transparency/Brightness

Transparency

If an object is selected, the first slider control relates to its transparency. Transparent sur
are not activated unless you have a QuickDraw 3D hardware renderer installed or are us
software plug-in renderer that supports transparency. If transparency is applied to an ob
which is subsequently transferred to a machine with the necessary hardware or software
object’s transparency will become apparent.

Select an object and use the Transparency slider control to adjust its transparency.
4-20



• When the transparency slider is to the left of the bar, the selected object is opaque:

As the slider is moved along the bar, the object becomes more transparent:
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Brightness

If a light is selected, the first slider control relates to the brightness of the light it emits:
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◆ Shininess/Spread

Shininess

If an object is selected, the second slider control relates to its shininess. Use the slider c
to adjust the degree of shine you place on an object. Shine is affected by directional ligh
as sun light or spot/point lights:
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Spread

If a spot light is selected, the second slider control allows you to adjust the lens angle of
light and narrow or widen the beam. Note that this option is not available for point lights:
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◆ Reflectivity/Sharpness

Reflectivity

If an object is selected, the third slider control allows you to adjust its reflectivity, which is
amount of ambient light the object reflects:
4-25
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Sharpness

If a spot light is selected, the third slider control allows you to adjust the sharpness of the
Move the slider control to sharpen or unsharpen the focus of the light. Note that this opti
not available for point lights:

◆ Name

The Name box provides a space to enter a name for an object or group of objects. This 
will be displayed whenever the object or group is selected.
4-26



 (such 
ected.
◆ Comments

The Comments box provides a space to enter details about an object or group of objects
as a description). These comments will be displayed whenever the object or group is sel
4-27
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THE HELP PALETTE

The Help palette displays coordinate values that show the position of the cursor and hel
sages or information relevant to the tool selected, cursor position or rendering status (if 
interactive renderer is being used).

Select Help from the Palettes menu to display the Help palette:

To resize the Help palette, click on the resize box in the bottom right corner of the palette
holding down the mouse button, drag to resize the palette. Release the mouse button w
palette reaches the desired size.
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WINDOW CONTROLS

The Window controls are displayed at the bottom of each window:

Selecting an option affects only that window, regardless of how many other views are op

◆ Zoom Out

Use the Zoom Out button to widen the focus of the camera’s view and make objects app
be farther away. Position the cursor over the Zoom Out icon and click once to zoom out 
slightly. Click and hold the mouse button down to continue zooming out. 

◆ Zoom In

Use the Zoom In button to narrow the focus of the camera’s view and make objects appe
be closer. Position the cursor over the icon and click once to zoom in slightly. Click and h
the mouse button down to continue zooming in.
4-29
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◆ View

Use the View popup menu to select a different view, including any view that you have sa
When you select a view option, the window will change to display your selection:

The Command key options and View menu can also be used to choose a view. See Change 
View on page 3-31 for further details.

◆ Default Color

The color displayed in the color block at the bottom right of the window toolbar is the curre
selected color. Any new items created (except lights and markers) will automatically be t
color, even if you are working in wire frame mode.
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To change the default color, click on the color block and select a new color from the Colo
Picker:

To change an object’s color, click on the color block and drag the color over the object. It
be highlighted by a bounding frame to show that it is selected. Release the mouse butto
apply the color to the object. You can also select an object, then go to the Color Picker a
select a new color to automatically apply that color.

◆ Window Resize

To change the size of the window you are working in, click on the Resize Window icon. H
down the mouse and drag to resize the window.
4-31
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Appendix A

Import Plug-ins

Import plug-ins are accessed via the Import submenu in the File menu.
Table of Contents

Introduction A-2

MacInteriors A-2
A-1

return to main table of contents
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◆ Int roduction

Open the File menu and select Import. A submenu lists the installed Import options:

The 3DMF Import option is not a plug-in but part of the core application. See 3DMF on 
page 3-10 for details.

Select the option to use from the list.

◆ MacInterio rs

The MacInteriors plug-in is used to import a 3D data file from Microspot’s MacInteriors appli-
cation into an Interiors document as 3DMF.

1. Select MacInteriors from the Import submenu and select a MacInteriors file from the 
standard select file dialog that displays.

2. The MacInteriors file will be converted into 3DMF and placed in the document. All the 
objects with their descriptions and prices will be imported; library items in the file but 
not included in the MacInteriors design will not be imported.

A
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Appendix B

Export Plug-ins

Export plug-ins are accessed via the Export option in the File menu.
Table of Contents

Introduction B-2
B-1

return to main table of contents
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◆ Introduction

Open the file menu and select Export. A submenu lists the installed Export options:

The 3DMF Export option is not a plug-in but part of the core application. See 3DMF on 
page 3-11 for details.

There are no Export plug-ins included in the Interiors product.
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Appendix C

Menu Command Plug-ins

Menu command plug-ins are accessed via the Plug-in menu.
Table of Contents

Introduction C-2

Auto Save C-2

Ceilings C-3

Construct Idler C-4

Floors C-5

Gravity C-6
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return to main table of contents
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◆ Introduction

Select the plug-in icon in the menu bar. A list of available menu command plug-ins displa

Select the plug-in name from the list to use it. Hold down the Option key and select the p
name to display any plug-in options that are available.

The first time a plug-in icon is selected, the top item in the menu is Last Plug-in, and this
grayed out. After selecting a plug-in, the top item will be the name of the last plug-in sele
This can be chosen by selecting the top item or typing Command - *.

◆  Auto Save

Select Auto Save to turn on the Auto Save feature. A dialog displays for you to enter a val
the Auto Save period.

Enter a value in minutes and click OK. A check mark will display next to the plug-in nam
show that Auto Save is on.
C-2
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After the specified period, a dialog displays warning that it is time to save and giving you
opportunity to turn Auto Save off, to close the dialog without saving, or to save the docum

To turn Auto Save off, select the plug-in name again from the plug-in menu.

◆ Ceilings

The Ceilings plug-in is used to add ceilings to selected objects drawn with the 4 Walls or 
drawing tools.

1. Draw an object using the 4 Walls or Walls drawing tool:

2. Select the object and choose Ceilings from the Command plug-in menu.
C-3
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3. An alert displays warning you that it will be difficult to position objects in a room on
the ceiling has been added, and that because of the way ceilings are designed, th
ing will not be seen unless viewed from below.

4. Click OK and a ceiling will automatically be added to the object.

◆ Construct Idler

The Construct Idler has two functions:

• Performing CSG (Constructive Solid Geometry) Boolean calculations.  CSG operations 
allow one geometry to cut into another — enabling you to see into a room through a
dow for example. The calculation is performed each time an object with a CSG attrib
changed, and may take a few seconds depending on the complexity of the documen
objects must have the appropriate CSG attributes applied to them, by using a plug-i
allows CSG attributes to be applied to objects, or by using library items that already
CSG attributes applied. Door and window library items supplied with the application,
walls drawn with the wall drawing tools, include the correct CSG attributes.

• Automatically simplifying objects as rendering speed decreases.  When the Construct 
Idler is checked on in the Plug-in menu and rendering speed falls below 4 renders p
ond, the plug-in starts to simplify the objects in the scene that contain the most trian
C-4
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by turning them into cubes. This allows you to continue to edit a complex document in
time, even on one of the slower computers. Any selected items, windows and doors a
affected by this process. Items are re-drawn in full once the editing action is complet

◆ Floors

The Floors plug-in is used to add floors to selected objects drawn with the 4 Walls or Wa
drawing tools.

1. Draw an object using the 4 Walls or Walls drawing tool:

2. Select the object and choose Floors from the Command plug-in menu.
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3. A floor will automatically be added to the object.

Note:  Floors are designed in such a way that they can only be seen if viewed from above

◆ Gravity

The Gravity plug-in is available as both a menu command plug-in and as a plug-in modi
See Gravity on page H-2 for details.
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Appendix D

Plug-in Palettes

Plug-in palettes are accessed via the Palettes menu. Select the palette name
from the list to open it.
Table of Contents
Introduction D-3

Tabbed palettes D-3

Color Palette D-6

Cursor Options D-7
Latching Options D-7
3D Cursor D-8

Libraries D-9
Selecting Library Items D-9
Storing Data D-10
Naming Items D-10
Retrieving Data D-10
Find D-10
Window Controls D-11

Zoom In/Out D-11
Arrows D-11

Libraries continued…
Menus D-12

File Menu D-12
View Menu D-13
Display Menu D-15

Lights D-16
Spot/Point Brightness D-16
Ambient Brightness D-16
Sun Brightness D-17
Show Lights D-17
Shadows D-17

NaviCam D-18
Height D-18
Position D-19
Zoom D-19
Position Buttons D-19
D-1
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Nudge D-20
Move D-20
Rotate D-21

Renderer Options D-21
Camera D-22
Renderer D-22

Renderer Options D-23
Style D-23
Shading D-24
Backface D-26
Show Grid D-27
Show Markers D-28
Use Hardware D-28

Textures D-28
Texture Palette Options D-29

Tripod D-32
Look At Selected D-32
Zoom D-33
Height D-33
Pan/Tilt D-33
Step/Crab D-33
Home View D-33
Take Picture D-33

Windows and Doors D-33
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INTRODUCTION

Click on Palettes in the application menu bar to display a list of available palettes. Selec
palette name from the list to open it.

The Tools, Info and Help palettes are not plug-in palettes but are part of the core applica
See Chapter 4 — Palettes on page 4-1 for details.

Tabbed palettes

All plug-in palettes are tabbed palettes.

When a palette is opened it displays in a window with the palette name on a tab at the top
palette.
D-3
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Tabbed palettes can be stacked together by simply clicking on the palette tab and dragg
palette onto the tab area of another tab palette:

Both palettes then appear in the same palette. To access a palette click on its tab.

Any number of tabbed palettes can be stacked together, although in practice you may w
limit this to the number of tabs that are visible in a palette.
D-4



to the 
To remove a tabbed palette from a stack, click on the palette tab and drag the palette on
desktop.

The palette will appear on its own, while the other palettes remain stacked together.
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Click on a palette tab and hold down the mouse button to display the tab menu. This pro
an alternate method of selecting other palettes or of disconnecting a palette from the sta

Double click on a tab to reduce the palette, and any others stacked with it, to just the pa
tab(s).

◆ Color Palette

The Color Palette plug-in provides a repository for 12 colors.

1. Select Color Palette from the Palette menu to display the Color Palette:

2. To use a color in the Color Palette, drag and drop it onto an object, the background
or color box in the Info Palette, or select an object in the document window and clic
a color in the Color Palette.

3. To change a color in the Color Palette, drag and drop a new color over an existing
or, when nothing is selected in the document, click on a color to open the color pic
and choose a new color.
D-6



 with 
e Pal-
 pal-

ts, 

ints of 
◆ Cursor Options

The Cursor Options palette allows you to control the alignment and positioning of objects
other objects, and the display and positioning of the cursor. Select Cursor Options from th
ettes menu to display the palette. Click on the shrink/expand button at the top right of the
ette to show or hide the lower section.

Latching Options

Latching is the alignment or snapping of points with other points. When positioning objec
latching lines will display (and sounds may play — see Play Latching Sounds on page D-8) 
when the latching points of the selected objects are aligned or snapped to the latching po
unselected objects.
D-7
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• Latching:  Click on this check box to turn the Latching features on or off. Alternatively 
hold down the Control key and press the space bar to switch Latching on or off.

• Latch Bounding Box:  Click on this check box to activate the eight corners of each obje
bounding box as latching points.

• Latch Mid Points:  Click on this check box to activate the mid points of each object’s 
bounding box as latching points, i.e. The points half way between the eight corner p
of the bounding box.

• Latch Hot Spots:  Click on this checkbox to specify that an objects ‘Hot Spots’ should b
activated as latching points. Hot Spots are points in addition to the corners and mid 
of an object’s bounding box. These are automatically added to wall objects and can
added to door and window objects. Hot Spots are added to wall objects at the top a
tom of the wall at each corner. When placing doors and windows in a document, the
dows and Doors palette includes a check box allowing you to choose whether to ad
Spots or not. If added, Hot Spots are positioned at the points where the window or d
intersects with the wall.

• Multiple Latch Lines:  If this option is checked on, latch lines will display for all current
alignments. If checked off, latch lines will display only for the first alignment found in
each axis.

• Play Latch Sounds:  Check this option on to play sounds according to the latching statu
objects being positioned. Three different sounds play in the following circumstances

If a point is aligned with, but not snapped to, another point.

If a point is snapped to another point.

If a point in no longer aligned with or snapped to another point.

• Latching Line Color:  Click on this box to display the Color Picker and select the color u
to display the latching lines.

3D Cursor

• Show Cross Hairs:  Check this option to display cross hairs showing the position of the 
sor in the document in 3D space.

• Floating Cursor:  The cursor defines a position and an orientation for entering new obj
and usually snaps to the surface of any object below the cursor arrow. Check this op
specify that the cursor should not snap to the surface of any object below it, and shou
orientate itself in relation to that surface.
D-8
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◆ Libraries

The Libraries palette displays libraries of furniture items, doors, windows, textures etc. tha
be used in your 3D scene.

Select Libraries from the Palette menu. The Libraries palette opens and contains any lib
files currently in the plug-ins folder:

Selecting Library Items

When you click on an item that is stored in a library it will be outlined with a black rectang
show it is selected:
D-9
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Storing Data

3DMF, PICT, QuickTime movie, sound data, and data in various other image formats ca
stored in libraries. Interiors includes several libraries of furniture and accessory items, do
and windows, colors and textures, but you can also use the Libraries palette to store you
items. To do this drag and drop objects/groups of objects from Interiors into a library.

Naming Items

Items are displayed in a library in the order in which they were entered.

If an item has a name attached to it, this name is displayed in the Name field at the botto
the palette when the item is selected. Unnamed items will display as untitled.

To name or rename an item, select its icon and enter a name in the Name field. Press th
or Return key, select another object or click on an empty space in the library and the item
be updated with its new name.

Retrieving Data

To retrieve data from a library, drag and drop an item directly into your Interiors docume

Find

Library items can be searched for by name. Enter text into the Find field at the top right 
Libraries palette. The first item found that matches the entered text will be selected:

Note:  The Libraries palette searches for names that match or start with the name you en
D-10
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Window Controls

Zoom In/Out

The Zoom controls at the bottom left of the palette can be used to increase/decrease the
the palettes contents:

Horizontal/Vertical Arrows

• Horizontal Arrow:  In the By Icon view, click on this button to display the Libraries pale
with a horizontal scroll bar. In the By List view, click on this button to display the prev
to the left of the item list:
D-11
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• Vertical Arrow:  In the By Icon view, click on this button to display the Libraries palette
with a vertical scroll bar. In the By List view, click on this button to display the previe
above the item list:

Menus

File Menu

New

Select New to open a new library. The standard dialog will display, allowing you to enter
name for the new library and specify a location to save it. A new, empty library will displa
the Libraries palette:
D-12
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Open

Select Open to open an existing library. A standard Open dialog will display for you to se
the library to open. The selected library will display in the Libraries palette.

Close

Choose to close the current library. The Auto Save feature saves the library file wheneve
add data, so you do not need to save any changes. The Libraries palette will remain ope
will display the contents of any other open libraries.

Close All

Choose to close all open libraries. The Libraries palette will remain open but will be emp

View Menu

By Icon

Select By Icon from the View menu to display picture previews of a library’s contents. 
Although the items’ names will not be displayed, you may still search for items by name u
the Find field at the top right of the Libraries palette. Librarian will display a preview of ea
item unless there is insufficient memory to create one. If Librarian recognizes the data ty
standard data type icon will display. If Librarian does not recognize the data type, an unk
data type icon will display.

By List

Select By List from the View menu to list a library’s contents by name. When By List is 
selected you can also choose whether to see a preview of an item when it is selected in 
D-13



• Preview above: The preview is displayed above the list:

• Preview to left: The preview is displayed to the left of the list:

• No preview: No preview of selected items is displayed:
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Display Menu

The display menu lists all the libraries currently open. Select a library’s name from the lis
display it or choose Show All to display the contents of all the open libraries in the order 
which they were opened.
D-15
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◆ Lights

The Lights Palette is used to control the various lighting features available in the applica
Select Lights from the Palettes menu to display the palette:

Note:  The Preferences dialog, accessed from the Edit Menu, contains a check box for G
Lights. If the Global Lights control is turned on, any changes made via the Lights palette
affect the whole document. If the Global Lights control is turned off, making changes in t
Lights palette will affect only the current window. See Preferences on page 3-24 for further 
details.

Spot/Point Brightness

Lights are placed in documents by dragging and dropping light objects or furniture items
including lights into the document. When a light is placed in a document, its color, bright
spread and sharpness can be adjusted via controls in the Info Palette. See Info Palette on page
4-16 for further details.

• To manipulate all point or spot lights at once, use the Spot/Point Brightness slider co
in the Lights Palette.

• Use the checkbox to the right of the slider bar to turn all the point or spot lights on o

Ambient Brightness

Ambient light is the equivalent of daylight. It is a diffused light that has no specific point o
gin and casts no shadows.

• Use the Ambient Brightness slider bar to adjust the brightness of the ambient light.
D-16
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• Click on the color box to display the Color Picker and select a color for the ambient l
or drag a color onto the color box.

• Use the checkbox to the right of the color box to turn ambient light on or off.

Sun Brightness

By default, sunlight shines from the South East at an angle of 45°. The direction of the sunlight 
can be adjusted using the Sun Direction plug-in. See Sun Direction on page H-4 for further 
details. Sunlight will affect your view of an object, and some surfaces will reflect more light
than others.

• Use the Sun Brightness slider bar to adjust the brightness of the sunlight

• Click on the color box to display the Color Picker and select a color for the sunlight, 
drag a color onto the color box.

• Use the checkbox to the right of the color box to turn sunlight on or off.

Show Lights

Use this checkbox to specify whether Point and Spot Light objects should be hidden or d
played. The effects of the lights will be apparent regardless. Non-interactive renderers (such as
the Microspot Renderer) will not display light objects whether they are hidden or not. See Ren-
derer Options on page D-21 for details of different renderers.

Shadows

These are not true shadows but projections of object shapes onto the grid. These are provided to 
help with the positioning and design of objects. The Shadows checkbox allows you to choose 
whether or not to display these shadows. Note that light settings have no effect on the display 
of shadows.
D-17
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◆ NaviCam

The NaviCam palette provides a way of controlling the camera position and view.

Select NaviCam from the Palette menu to display the NaviCam palette.

The red square displayed in the palette, both in the height area and in the position plan,
sents the camera. The line from this square shows the camera view direction and at the
this line is the look at point or point of interest.

Height

Use the controls in the Height Area to adjust the position of the camera, or point of intere
the Y dimension. 

The long green line in the Height Area represents the grid height. The lines above it repr
height as determined by the size of the grid and each grid square.

• Click on the camera square and move it up or down to change the camera height wh
maintaining the point of interest.

• Click on the view direction line (or anywhere in the Height Area except the camera sq
and drag up or down to change the height of the point of interest without changing t
camera height. This is the same as tilting the camera.

• Hold down the Option key, click anywhere in the Height Area and drag up or down to
adjust the height of the camera and move the point of interest relative to the camera 

Height Area
Position Plan

Zoom Position Buttons

Grid Height
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If the camera is moved out of the height range shown, the display will be rescaled so tha
camera square can still be seen. When the camera is moved back into range, the display
rescaled again.

Position

Use the controls in the Position Plan to adjust the position of the camera or the point of in
in the X and Z dimensions.

The Position Plan displays an image of the 3D scene in plan view.

• Click on the camera square and drag to change the position of the camera while ma
ing the point of interest.

• Click on the view direction line (or anywhere in the Position Plan except the camera 
square) and drag to change the position of the point of interest without moving the ca
position. This is the same as turning the camera.

• Hold down the Option key, click anywhere in the Position Plan and drag to move the
era and move the point of interest relative to the camera position. This is the same a
step and crab movements of the camera.

If the camera is moved out of the plan shown, the display will be rescaled so that the cam
square can still be seen. When the camera is moved back into range, the display will be
rescaled again.

Zoom

Click on the Zoom button and drag up or down to zoom in or out on the scene.

Position Buttons

Use the position buttons to move either the camera or the point of interest to predefined 
tions.

• Click on the position buttons to move the camera while maintaining the point of inter
0° moves the camera to directly behind the point of interest, 90° to the right, 180° directly 
in front of, 270° to the left, and so on.

• Hold down the Option key and click on the position buttons to move the point of inter
while maintaining the camera position. 0° moves the point of interest to directly behind th
camera, 90° to the right, 180° directly in front of, 270° to the left, and so on.
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• Click on the ‘Mid’ button to move both the camera and the point of interest to predet
mined locations. The point of interest is positioned at the centre of the grid. The cam
placed half way between the centre and the side of the grid, directly in front of the po
interest. The camera will be at approximately eye height and tilted down slightly.

◆ Nudge

Use the Nudge palette to move or rotate an object by a specified amount.

Select Nudge from the Palettes menu to display the Nudge palette:

Move

1. Select an object in the document window.

2. Enter a value in the Move box in the Nudge palette. The units used will depend on 
set for the document in the Options menu. See Options Menu on page 3-34 for furthe
details.

3. Click on the control buttons to choose the direction in which to move the selected
object. The direction relates to the current view.

Move Up

Move Down

Move Left Move Right

Move Closer Move Further Away
D-20
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Rotate

1. Select an object in the document window.

2. Enter a value in degrees in the Rotate box in the Nudge palette.

3. Click on the control buttons to choose the direction in which to rotate the selected
object. The direction relates to the current view.

◆ Renderer Options

The Renderer Options plug-in palette is used to control the way that the document is disp
Choose Renderer Options from the Palettes menu to open the palette:

Rotate Up

Rotate Down

Rotate Left Rotate Right

Rotate Anticlockwise Rotate Clockwise
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Camera

Select Perspective or Orthographic from the Camera pop-up menu.

• Perspective:  Objects are displayed in perspective mode to give the illusion of depth. P
lel lines are drawn so that if extended, they would converge at a given point:

• Orthographic:  Objects are displayed in Orthographic mode. Parallel lines remain para
regardless of the distance they are supposed to be from the camera:

Renderer

Click on the Renderer popup menu to display any available renderers. As QuickDraw 3D
sion 1.5 and later supports plug-in renderers, any plug-in renderers that are installed wil
included in the list.
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• Wire Frame:  The surfaces of objects are not filled; only the edges of the surfaces are 
played:

• Interactive:  Objects in the document are rendered using the QuickDraw 3D interactive
derer.

• Microspot Renderer:  The scene is rendered using the Microspot non-interactive render
produce a high quality final render. See Appendix I on page I-1 for further details.

Renderer Options

To the right of the Renderer popup menu is a button for Renderer Options. This is only ac
a non-interactive renderer is installed and selected. Click on the button to display any ava
options for the currently selected non-interactive renderer.

Note:  Holding the Option key down while selecting the renderer will also display any optio
available.

Style

The Style pop-up menu is not available when the Wire Frame renderer is selected. Select
the following options from the menu:

• Filled:  All surfaces are filled and rendered. Objects appear to be solid.
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• Edges:  Only the edges of objects are rendered. This is different from Wire Frame mo
that lines are rendered according to the orientation of the object and any light sourc
rather than the lines being displayed as one solid color:

• Points:  Only the vertex points of objects are rendered. Points are rendered according
orientation of the object and any light sources:

Shading

Select Plain, Smooth or Best from the Shading pop-up menu.
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• Plain:  Surfaces are filled but not smoothed and steps of color can be seen within som
objects. Shading is applied according to the angle of the surface and any light sourc
will affect the object:

• Smooth:  Surfaces are filled and smoothed. Shading is applied according to the angle 
surface and any light sources that will affect the object:
D-25
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• Best:  Surfaces are filled and smoothed. Shading is applied according to the angle of
surface and any light sources that will affect the object. This option also displays the
reflections of any lights:

Backface

The backface of an object is the side that faces away from the camera.

Select Show, Remove or Flip from the pop-up menu.

• Show:  Select this option to show the backface of an object. This will not make any vis
difference if the object surfaces are filled, but if you are viewing the objects in wire fr
mode, you will be able to see the wire frame on the backface of the object:
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• Remove:  Select this option to hide the backface of an object. This will not make any d
ence if the object surfaces are filled, but if you are viewing an object in wire frame m
its backface will not be displayed:

• Flip:  The Flip option flips the backface so that the outside surface is now on the insid
This does not affect the shape of the object, but may alter the way it is rendered:

Show Grid

Documents are automatically displayed with a grid to help you design and position objec
3D. When this option is enabled, the grid will be displayed. Uncheck this option to hide th
grid.
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Show Markers

When text and sound markers are placed in a document, you can choose whether or no
play them. Check the Show Markers option to display markers, or leave it unchecked to 
markers. There is no marker tool in Interiors, but text and sound markers can be dragge
dropped into the document. See Appendix J on page J-1 for further details.

Use Hardware

If you have a hardware renderer installed in your computer, check this box to specify tha
want to use it.

◆ Textures

Use the Textures Palette to manipulate a texture applied to an object.

Select Textures from the Palettes menu to display the Textures palette:

Click on the shrink/expand button in the top right corner of the palette to extend it:
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The contents of the palette will be grayed out unless an object with a texture applied to i
selected.

When a texture is applied to an object it is scaled/stretched to fit once on each surface. T
ture can then be manipulated using the controls in the Textures palette.

Texture Palette Options

• Rotation : Enter a value between 0 and 359.9 in the rotation field and press the Retur
Enter or Tab key or use the rotation slider to adjust the degree of rotation of the textu
applied to the object.

• Offset:  Select Offset from the pop-up menu and the two slider bars to the right of the
up menu will relate to horizontal and vertical offset. The values for horizontal and ver
offset can be linked by clicking on the constrain box to the right of the slider bars.

Horizontal Offset:  Enter a value between 0 and 1 in the Horizontal Offset field and p
the Return, Enter or Tab key or use the slider bar to move the texture across the ob
a horizontal direction.

Vertical Offset:  Enter a value between 0 and 1 in the Vertical Offset field and press 
Return, Enter or Tab key or use the slider bar to move the texture across the objec
vertical direction.

• Scale:  Select Scale from the pop-up menu and the two slider bars to the right of the po
menu relate to horizontal and vertical scale. The values for horizontal and vertical sc
can be linked by clicking on the constrain box at the right of the slider bars.
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Horizontal Scale:  Enter a value between 0 and 25 in the Horizontal Scale field and p
the Return, Enter or Tab key, or use the slider bar to change the horizontal scale o
texture on the object.

Vertical Scale:  Enter a value between 0 and 25 in the Vertical Scale field and press
Return, Enter or Tab key or use the slider bar to change the vertical scale of the te
on the object.

• Flip Horizontal:  Check the Flip Horizontal check box to flip the texture applied to the 
object around the horizontal axis.

• Flip Vertical:  Check the Flip Vertical check box to flip the texture applied to the object
around the vertical axis.

• Clamp X:  Check the Clamp X check box to prevent the texture being repeated in the 
axis. The texture offset can then be adjusted to position the strip of texture on the su
D-30
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• Clamp Y:  Check the Clamp Y check box to prevent the texture being repeated in the Y-
The texture offset can then be adjusted to position the strip of texture on the surface

• If the texture is clamped in both the X and Y axes it is not repeated in either direction
texture can then be scaled and positioned on the surface as desired.

• Play Movie:  This option is only available if a movie has been applied to an object as a
ture. Click on the Play Movie button to start the movie playing.

• Stop Movie:  This option is only available if a movie has been applied to an object as a
ture. Click on the Stop Movie button to stop the movie playing.

• Import:  Click on the Import button to display a standard dialog that allows you to sele
PICT, TIFF, JPEG, GIF, PICT clipping or movie file to import as a texture. To import 
movie as a texture QuickTime version 2.0 or later must be installed. TIFF, JPEG, GIF
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Movie Files can be dragged and dropped directly onto objects in the document, as lo
the Textures palette plug-in is loaded.

• Sound:  Use the Sound control to change the volume of the sound of any movie appli
a texture on a selected object. Click on the sound icon and a pop-up menu displays.
the level of sound required.

◆ Tripod

The Tripod palette provides a way of changing the view in the current document window

Select Tripod from the Palettes menu to displays the palette:

The Tripod palette displays a graphic of a camera on a tripod. A variety of buttons provid
trols for manipulating the camera, the above dialog shows how those controls are used. I
cases click on the button to perform the relevant action. When using those buttons marke
italic text, click on the button and drag to perform the desired action.

Look At Selected

Select an object in the document and click on the Look At Selected button to position the
era to centre the selected object in its view.

Height

Step/Crab

Zoom

Pan/Tilt

Look At Selected

Zoom Out Zoom In

Adjust Height

Home View

Crab

Step

Crab

Take Picture

Pan/Tilt
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Zoom

The Zoom controls are used to narrow or widen the focus of the camera lens

Height

The Height controls are used to change the height of the camera.

Pan/Tilt

The Pan/Tilt controls are used to change the camera’s angle by turning it left and right or 
it up and down.

Step/Crab

The Step/Crab controls are used to move the camera closer, further away, left, and right

Home View

Click on the Home View button to return the camera to its initial position (the view display
when a new file is opened).

Take Picture

Click on the Take Picture button to save a PICT image of the window contents at 72dpi.

◆ Windows and Doors

The Windows and Doors palette is used to accurately position windows and doors in a waSee 
Windows and Doors on page G-10 for information about placing windows and doors in a
ument.

Open the Windows and Doors palette by selecting its name from the Palettes menu, and 
window or door item in the document.
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• Centre in wall:  Click on this button to centre a window or door in the wall. Doors will b
positioned in the centre of the length of wall but will remain on the grid, windows will
positioned centrally in both dimensions.

• Reverse:  Click on this button to mirror a window or door about the vertical axis. Note t
this does not actually rotate the item, just changes its appearance.

• Measurements:  The dimensions of the window/door, the length of the wall on either si
of the window/door and the height of the window/door above the grid displays in field
the palette. Type in new values to change these measurements as required. When y
in a field to enter/revise values, a black arrow shows which dimension that value ref

• Length includes wall thickness:  Check this check box if you wish the measurements d
played for the length of the wall on either side of the window/door to include the thick
of the wall. This will depend on whether you are working from internal or external me
surements.

• Add latch points:  Latch points are used to align and snap objects to. See Latching Options 
on page D-7 for more details. Latch points are automatically present at the corners an
mid points of an object’s bounding box. Click on this checkbox to specify that additio
latch points should be added at the points where the window/door intersects with the
D-34
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Appendix E

Idler Plug-ins

Idler plug-ins have no interface and run constantly in the background when
loaded.
E-1
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There are no Idler plug-ins included in the Interiors product.
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Appendix F

Plug-in Tools

Individual plug-in tools are discussed in Appendix G — Plug-in Geometries
and Appendix H — Plug-in Modifiers. This appendix provides information
relevant to both types of plug-in tool.
Table of Contents

Introduction F-2
Configure The Tools Palette F-2
Tool Options F-3
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INTRODUCTION

Plug-in tools are either plug-in geometries or plug-in modifiers. See Appendix G — Plug-in 
Geometries and Appendix H — Plug-in Modifiers for details of individual plug-ins. When 
loaded, plug-in tools appear in the Tools palette and can be positioned in the palette by the u
as discussed below.

◆ Configuring The Tool s Palette

When Interiors is launched with all the plug-ins loaded, the plug-ins are placed in the Tools 
palette in a default order. If you have purchased any additional plug-ins they will be classed as 
either Plug-in Geometries or Plug-in Modifiers and will be stacked together under a gene
Plug-in Geometries or Plug-in Modifiers button at the bottom of the Tools palette.

The Tools palette is configurable, so you can move tools around to position them in the loca-
tion or group that is most convenient or logical for you.

Configure the Tools palette in the following way:

• Click on a tool and hold down the mouse button to display a pop-up menu showing the 
other tools in the stack (if any). Select the name of a tool in the pop-up menu to select
tool and bring it to the top of the stack.

• To move a tool, hold down the Command key, click on the tool and drag it to a new loca-
tion.

• Drop a tool onto another tool to stack them together.
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• Drop a tool onto the four selection tools at the top of the palette to separate it from a 
of stacked tools and add it to the top of the tool palette as an individual tool.

◆ Tool Options

To open a dialog showing any options available for a tool, use either of the following met

• Hold down the Option key and select the tool in the Tools Palette.

• Click on the tool in the Tools palette and hold down the mouse button. Select the sam
from the pop-up menu that displays.

Note:  There are no options available for the Arrow, Rotate, Rectangular Marquee and Ha
tools.
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Appendix G

Plug-in Geometries

Plug-in Geometries are plug-in tools that are used to create objects. When
installed they are located in the Tools palette.
Table of Contents
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◆ Introduction

When loaded, Plug-in Geometries appear in the Tools palette. The position of each plug
the Tools palette will depend on how the user has configured the palette. See Configuring The 
Tools Palette on page F-2 for more details. The default arrangement is shown below.

Select the plug-in tool to use by clicking on its icon in the Tools palette.

4 Walls

Windows & Doors

Walls

Furnishings
G-2
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◆ 4 Walls

The 4 Walls plug-in is used to draw a regular, four-walled room. Walls are always drawn 
pendicular to the grid and resting on the grid.

1. Select the 4 Walls plug-in from the Tools palette. The view will change to show an
orthogonal, top view.

2. Click on the grid and, holding down the mouse button, drag to draw 4 walls:

3. Release the mouse button and the Edit options dialog displays:
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4. If necessary, enter values in the Width, Depth, Height and Wall thickness fields to 
ify the width and depth of the room, the height of the walls and the wall thickness.

5. Click OK. The view will change back to the previous view, and the walls will display
the dimensions specified. If the walls are the first items drawn, the room will be au
matically centred on the grid.

To change the default settings for the 4 Walls plug-in, hold down the Option key and sele
4 Walls tool. The Wall Options dialog displays:

• Wall thickness:  Enter a value to specify the default thickness for walls.

• Wall height:  Enter a value to specify the default height for walls.
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• Internal measurement:  Click on the Internal measurement radio button to specify that 
ues entered in the Entry options dialog (the dialog that displays after walls are drawn
relate to the measurements of the internal walls.

• External measurement:  Click on the External measurement radio button to specify that 
ues entered in the Entry options dialog (the dialog that displays after walls are drawn
relate to the measurements of the external walls.

• Show info editor:  Check the Show info editor check box to specify that the Entry optio
dialog should appear after walls are drawn. Uncheck this check box if you do not wan
dialog to display.

Note:  The size, position and rotation of the walls are locked on entry. If you unlock the wa
using the controls in the Info palette, the width and depth of the room, the height of the w
and the rotation of the room can be adjusted using the Info palette or the Arrow tool, but 
wall thickness will be scaled proportionally. See Info Palette on page 4-16 for more informa
tion.

◆ Furnishings

The Furnishings plug-in allows you to easily access furniture items to place in your docu

1. Click on the Furnishings plug-in icon in the Tools palette. The document window w
change to display a top view and the Furnishings dialog will display:

The Nudge palette will also be opened (if it is loaded) to aid in the positioning of ite
See Nudge on page D-20 for information about using the Nudge palette.
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2. Click on one of the buttons in the dialog to access furnishings of that type.

The Libraries palette is opened and the appropriate furniture library displayed — a
long as a library (or an alias) with the specified name is located in the plug-ins fold
See Libraries on page D-9 for information regarding the Libraries palette.

3. Furniture items can then be dragged out of the library and dropped into the room 
required. The furniture items can be resized and positioned as necessary.
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◆  Walls

The Walls plug-in is used to create rooms other than those with four regular walls. Walls 
always drawn perpendicular to the grid and resting on the grid.

1. Select the Walls plug-in from the Tools palette. The view will change to show an or
onal, top view.

2. Click in the document at the point you wish to start drawing a wall. Holding down t
mouse button, drag along one of the constrainer lines that display to draw the wal

Note:  Currently only perpendicular walls can be drawn. To enter walls with internal w
measurements, draw the room in a clockwise direction as viewed from above; to e
walls with external wall measurements, enter walls in an anti-clockwise direction a
viewed from above.
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3. Click at the point you want the wall to end. The Edit options dialog displays:

• If you have drawn the wall to exactly the correct length, and the default settings fo
height and thickness of the wall are correct, click OK.

• To change any of the walls dimensions, enter new values in the Length, Height a
Wall thickness fields and click OK.

• If this is the last wall to be drawn click on the Done button.

• To enter the wall again, click the cancel button.

• To prevent this dialog from displaying, hold the Option key down when clicking o
the point you want the wall to end.

4. After closing the Edit options dialog, draw the next wall by dragging along one of t
constrainer lines displayed:
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5. Click at the point you want the wall to end. The Edit options dialog will display aga
In this example, the height of the second wall has been increased.

6. Continue drawing further walls in the same way, adjusting the height and thicknes
the walls as required.

While entering walls, if the cursor is aligned with another wall corner, an alignment
will display showing the alignment, and the cursor will change to a hollow cross.

Press the delete key at any time while entering walls to delete the wall currently b
entered. The cursor will be move back to the previously entered wall.

7. When the last wall is drawn, click on the Done button in the Edit options dialog. Th
view will change back to the previous view and the walls will display as specified. If
walls are the first items drawn, the room will be automatically centred on the grid.

To change the default settings for wall height and thickness for the Walls plug-in:
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1. Hold down the Option key and select the Walls tool to display the Wall Options dia

2. Enter a value in the Wall thickness field to specify the default thickness for walls.

3. Enter a value in the Wall height(s) field to specify the default height of the walls.

◆ Windows and Doors

The Windows and Doors plug-in allows you to easily access window and door items to pla
your document.

1. Click on the Windows and Doors plug-in icon in the Tools palette. The document w
dow will change to display a view from the middle of the room looking towards the
back wall. The Windows and Doors palette will be opened and the Windows and D
dialog will display:

The NaviCam palette will also display to enable you to easily change the window v
See NaviCam on page D-18 for details of how to use the NaviCam palette.
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2. Click on one of the buttons in the dialog to access that type of object.

The Libraries palette is opened and the appropriate library displayed — as long as
library (or an alias) with the specified name is located in the plug-ins folder. See Librar-
ies on page D-9 for information regarding the Libraries palette.

If you click on the button marked ‘Other’ the standard Open File dialog is displaye
You can then select the file to open.

3. Windows and doors can then be dragged out of the library and dropped onto the w
the room. They can then be resized and positioned as required by dragging the ob
by using the Windows and Doors palette. See Windows and Doors on page D-33 for 
more details.
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Appendix H

Plug-in Modifiers

Plug-in Modifiers are plug-in tools that are used to modify objects or the
scene in some way. When installed they are located in the Tools palette.
Table of Contents
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◆ Introduction

 When loaded, plug-in modifiers appear in the Tools palette. The position of each plug-in 
palette will depend on how the user has configured it; the default arrangement is shown 
See Configuring The Tools Palette on page F-2 for more details.

◆ Gravity

The Gravity plug-in is used to place objects on the grid.

Select the Gravity tool from the Tools palette. As the cursor is moved over the document
dow it will change to a downward arrow. The active point is at the tip of the arrow. Click o
object and it will be moved so that its lowest point is placed on the grid.

If an object has been locked by clicking on the padlock icon in the top right corner of the
palette, or by selecting Lock from the Options menu, you will not be able to use the Grav
tool to drop the object to the grid. 

If the object position is locked only in the Y-axis, the Gravity tool will over-ride this restrai
and can be used to drop the object to the grid. If you have several objects selected, som
which may be locked in the Y-axis, hold down the Shift key when using the Gravity tool to
vent these locked objects from being dropped to the grid.

Light Director

VR

Take Picture

Sun Direction

Gravity

Print
H-2
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See Position on page 4-16 and Lock on page 4-19 for more details.

The Gravity Menu Command Plug-in

Make a selection in the document window and choose Gravity from the Plug-in menu. Th
selected object(s) will be placed on the grid.

◆ Light Director

The Light Director plug-in is used to direct one or more spot lights in a particular directio

Select the light(s) to direct, then select the Light Director tool in the Tools palette. In the 
ment window, click at the place you want the lights to point. The light(s) will be rotated to
point at the place specified.

Lights can also be selected using the Light Director tool by selecting the tool and clicking
light. Hold down the Shift key and click on additional lights to increase the selection. Hol
down the Shift key and click on a selected light to remove it from the selection.

◆ Print

Use the Print plug-in to display the standard Print dialog and print the current document 
When the Print plug-in is selected, the Renderer Options palette is automatically opened 
you can make any necessary changes to the way the document is displayed. See Renderer 
Options on page D-21 for more details.

Use one of the following methods to display the Print dialog:

• Click on the Print plug-in then click in the document view.

• Hold down the Option key and select the Print tool.

• Click on the Print tool and hold down the mouse button. Select the same tool from th
up menu that displays.

Enter the required number of copies etc. in the Print dialog and click OK to print the view
H-3
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◆ Sun Direction

The Sun Direction plug-in is used to adjust the direction the sun light shines in.

When the Sun Direction plug-in is selected, the Lights palette is automatically opened so
you can make any necessary changes to the way the scene is lit. See Lights on page D-16 for 
more details.

1. Select the Sun Direction tool from the Tools palette.

2. The document window changes to show a top view. The current direction the sun 
is shining in is depicted as a red line with a handle at the end:

3. Click on the handle and holding down the mouse button drag to change the positi
the source of the sun light.
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4. Hold down the Control key as you drag to move the position of the source of the s
light closer or further away.

5. Movement of the sun direction line can be constrained to the X, Y and Z axes by ho
down the Shift key.

6. Release the mouse button to drop the handle at its new location.

◆ Take Picture

Click on the Take Picture plug-in to save a PICT image of the window contents at 72dpi.

When the Take Picture plug-in is selected, the Renderer Options palette is automatically
opened so that you can make any necessary changes to the way the document is displaSee 
Renderer Options on page D-21 for more details.

Use one of the following methods to display the standard Save dialog:

• Click on the Take Picture plug-in then click in the document view.

• Hold down the Option key and select the Take Picture tool.

• Click on the Take Picture tool and hold down the mouse button. Select the same too
the popup menu that displays.

Specify a name for and location to save the file in the save dialog and click OK to save th
image.
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◆ VR

The VR plug-in is used to pan and tilt the camera using control mechanisms similar to th
found in QuickTime™ VR.

When the VR plug-in is selected, the NaviCam palette is automatically opened so that yo
use it to make changes to the camera position and view. See NaviCam on page D-18 for more
details.

Select the VR tool from the Tools palette and click in your document window.

• To pan the camera (turn it left and right): hold down the mouse button and drag the m
left and right.

• To tilt the camera: hold down the mouse button and drag the mouse up and down. T
is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the mouse button and the
mand key and drag the mouse left and right.

• To move the camera forwards and backwards: hold down the mouse button and the 
mand key and drag the mouse up and down.

• To zoom in: hold down the Shift key.

• To zoom out: hold down the Control key.

As you move, the cursor changes to an arrow head pointing in the direction you are mov
all cases, the further you move the mouse from the point first clicked on, the faster the c
will move. 

Alternatively, select the VR tool and use the arrow keys to move the camera:

• To pan the camera (turn it left and right): use the left and right arrow keys.

• To tilt the camera: use the up and down arrow keys. The tilt is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the Command key and us
left and right arrow keys.

• To move the camera forwards and backwards: hold down the Command key and use
and down arrow keys.
H-6
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Appendix I

Microspot Plug-in Renderer
Table of Contents
Introduction I-2

Register the Microspot RendererI-2

Select the Microspot Renderer I-2

Renderer Options I-3
Renderer Serial Number I-3
Renderer Options Dialog I-5
Shadows I-5

On/Off I-5
Resolution I-5
Soft Edges I-6

Anti-alias Image I-6

Improving Rendering Speeds I-6
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◆ Introduction

The Microspot Renderer is a QuickDraw 3D™ plug-in renderer that provides the followin
features in addition to those provided by the software QuickDraw 3D interactive rendere
transparency; shadows; pixel level lighting calculations; image anti-aliasing. These featu
allow you to render a high quality, more realistic 3D scene — in particular the pixel level 
ing calculations give more accurate representations of how lighting affects surfaces.

◆ Registering the Microspot Renderer

Register the Microspot Renderer by running the Register Now utility before using the pro
or register it when you require it as described later in this section. In either case you will
required to enter your name, company name (if applicable) and a valid serial number. W
this information the renderer can still be used, but the scene will be rendered with a demo
across it.

◆ Selecting the Microspot Renderer

The Microspot Renderer is accessed via the Renderer Options palette. Select Renderer 
from the Palettes menu to display this palette:
I-2
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Click on the Renderers pop-up menu, the Microspot Renderer will be listed beneath the 
frame and Interactive Renderers:

If you have not already registered the renderer, the first time you select the Microspot Ren
hold down the Option key as you do so. This will enable you to enter your Renderer seria
ber (see below). After this just select the Microspot Renderer to render the current scene
the Microspot Renderer.

◆ Renderer Options

In the Renderer Options palette select the Microspot Renderer and click on the Options 
in the upper right corner of the palette. 

Renderer Serial Number

If the renderer has not already been registered, the first time you select Options, a dialog
display asking for your details and Renderer serial number:
I-3



 Ren-
r are 
 a 
Enter your name and serial number (and company name if applicable) and click OK. The
derer serial number will be included in the Interiors package. If a name and serial numbe
not entered the scene will still be rendered with the Microspot Renderer, but there will be
demo panel across it.
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Renderer Options Dialog

The Microspot Renderer's Options dialog will then display:

Alternatively hold the Option key down when selecting the Microspot Renderer in the Re
derer pop-up menu to display the Microspot Renderer's Options dialog. The dialog provi
controls to turn shadows on and off, adjust the resolution of the shadows, soften the edg
shadows and choose how much image anti-aliasing to apply. Click OK when you have s
rendering options to render your scene.

Shadows

On/Off

If you turn on shadows it will increase memory usage by a significant amount and also s
down the rendering greatly. Rendering speed and memory usage are directly proportiona
number of lights in the scene. Point lights and wide spot lights (greater than a 60° angle) will 
use 6 times as much memory as a normal narrow spot light although they will not decrea
rendering speed any more than a normal light. Any directional light will use the same am
of memory as a norma point light. In Interiors, if you do not need the sun light, turn it off 
save memory.

Resolution

Increasing the shadow resolution will not only increase your memory usage significantly,
will slow down your rendering too. We recommend that you keep the slider in the middle
unless you really need sharper shadows. See Improving Rendering Speeds on page I-6 for m
details.
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Soft Edges

Turning on soft edges will soften the edges of the shadows and will slow down the shad
calculations only a little. This will not use any extra memory.

Anti-alias Image

A typical 640 x 480 render will require 2.5 Mb of RAM for the image buffer. If you turn on
image anti-aliasing, the renderer will use 4 times as much memory as this for good anti-
ing, 9 times for better anti-aliasing and 16 times for best anti-aliasing. Rendering speed w
reduced by the same factors.

◆ Improving Rendering Speeds

If rendering speeds are very slow the renderer will start to draw your image in bands. Th
not a problem in itself, it will just take a long time for the complete scene to be drawn. If 
want to try to speed rendering up, try the following: turn off image anti-aliasing or reduce
shadow resolution. If the renderer still draws in bands, reduce the number of lights (espe
point lights) in the scene.
I-6
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Appendix J

Drag and Drop

This section discusses dragging and dropping colors, 3D objects, text, TIFF,
JPEG, GIF and Movie files to and from Interiors documents.
Table of Contents

Drag Output J-2

Copy J-3

Drag Input J-3

Notes J-4
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DRAG OUTPUT

You can drag a color from the Window control panel, Lights Palette or Info Palette to:

• A 3D object in Interiors

• The Scrapbook

• Another Lights Palette or Info Palette color or any other palette that includes color bu

• Desktop patterns

• The Finder Desktop or a Folder window

• The Finder Trash Can

• An Interior’s library

• A PICT-compatible, Drag & Drop aware application (like PhotoShop 3.0.4 or later)

You can drag a 3D object or an entire scene (by holding down the Option key and clickin
the background) to:

• Another view of the same file in Interiors

• The window of a different file in Interiors

• A 3DMF-compatible, Drag & Drop aware application

• A PICT-compatible, Drag & Drop aware application (like PhotoShop 3.0.4 or later)

• The Scrapbook

• Desktop patterns

• The Finder Desktop or a Folder window

• The Finder Trash Can (to delete the object)

• An Interior’s library

• The Puzzle

You can also drag:

• A 3D object with a sound attribute to a sound-compatible, Drag & Drop aware applic

• A 3D object with a text attribute to a text-compatible, Drag & Drop aware application
SimpleText or NotePad
J-2
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When you copy selected items from an Interiors document, the following types of data a
on the Clipboard:

• A PICT of the selected items which is the same size as the front window

• A 3DMF as a single grouped item.

• A sound if a selected item has a sound attribute

• Text if there is a text marker included in the selection

DRAG INPUT

Drag a PICT file from the Finder to:

• A 3D object to create a texture of the picture wrapped around the object

• The document window to make a background picture

• The document window to make a foreground picture (hold down the Control key whe
dropping the file)

• The grid to make a rectangle with a texture of the picture

Drag a text file from the Finder to:

• A 3D object to create a texture of the text wrapped around the object

• The background to make a background picture of the text

• The grid to create a text marker 

Drag a TIFF, JPEG GIF or Movie file from the Finder to:

• A 3D object to create a texture of the text wrapped around the object (if the Textures
ette plug-in is installed in the Plug-ins folder).

Drag a 3DMF file from the Finder to:

• A Interiors document (to import it)

Drag a sound file from the Finder to:

• A 3D object (to add the sound as an attribute)

• The grid or background to create a sound marker
J-3



the 

ption 

 
or on 

place 
Drag a clippings file of the following type from the Finder:

• A PICT clipping (See Drag a PICT file from the Finder)

• A text clipping (See Drag a text file from the Finder)

• 3DMF clipping (See Drag a 3DMF file from the Finder)

• Sound clipping (See Drag a sound file from the Finder)

Drag an Interiors color clipping file (created by dragging a color from a color button into 
Finder) from the Finder to:

• A 3D object to change its color

• The grid to change its color

• The background to change its color

• The window toolbar to change the default color, as well as any selected items

• The Lights Palette to change the color of the appropriate light

• The Info Palette to change the color of the selected object/light

• Any other palette that includes color buttons

Other applications that you can drag data into Interiors from:

• The Scrapbook (PICT, text, sound, 3DMF, Interiors color)

• An Interior’s library (PICT, text, sound, 3DMF,Interior’s color, Movie)

• The NotePad (text)

• The Puzzle (PICT)

• Desktop Patterns (PICT)

• PhotoShop 3.0.4 or later (PICT)

NOTES

• To drag and drop locked items out of an Interiors document window, hold down the O
key.

• Holding down the Control key as you drag and drop an item onto an object or group
ungroups the object or group and places the item on just one surface of the object, 
one item in the group.

• Hold down the Option key as you drag a 3D object to leave a duplicate in the same 
as the original.
J-4
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Appendix K

Plug-in Directory

Lists the application’s plug-ins by name, provides details of the plug-in’s
type and status, and offers a brief description of its use.
K-1
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# Name  Type    Use the plug-in to…

1 4 Walls Geometry Create a regular 4 walled room.

2 AutoSave Menu Command Display alert to save document
intervals.

3 Ceilings Menu Command Add ceilings to selected objects
Walls or Walls drawing tools.

4 Color Palette Palette A repository for 12 colors.

5 Construct Idler Menu Command Performs Boolean calculations
simplifies objects.

6 Cursor Options Palette Alignment, snapping and curso

7 Floors Menu Command Add floors to selected objects d
Walls or Walls drawing tools.

8 Furnishings Geometry Easily access furniture items to
document.

9 Gravity Menu Command & 
Modifier

Place objects on the document g

10 Libraries Palette Store and retrieve data. Contain
furniture and accessory items.

11 Light Director Modifier Direct one or more spot lights to
particular direction.

12 Lights Palette Control the application’s lighting
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13 MacInteriors Import Import 3D data files from Micros
MacInteriors application.

14 Microspot Renderer Renderer Produce high-quality final rend

15 NaviCam Palette Control the camera position and

16 Nudge Palette Move or rotate an object by a sp

17 Print Modifier Display the standard Print dialog
document view.

18 Renderer Options Palette Change the way the documen
it are displayed.

19 Sun Direction Modifier Adjust the direction the sun light

20 Take Picture Modifier Save a PICT image of the windo
72dpi.

21 Textures Palette Import and manipulate a texture
object and play movies as texture

22 Tripod Palette Change the document view.

23 VR Modifier Pan and tilt the camera using con
similar to those found in QuickTim

24 Walls Geometry Create rooms other than those w

25 Windows & Doors Palette & Geometry Accurately position window an
walls.

# Name  Type    Use the plug-in to…
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Appendix L

Command Key Table

Command key shortcuts can be used to perform many actions. The following
table lists those key combinations.
Table of Contents

Command Key Table L-2
File Menu L-2
Edit Menu L-2
View Menu L-2
Options Menu L-3
Plug-in Menu L-3
Help Menu L-3
Others L-3
L-1
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COMMAND KEY TABLE

Action Command Key

File Menu

New Command N

Open Command O

Close Command W

Save Command S

Print Command P

Quit Command Q

Edit Menu

Undo Command Z

Undo F1

Cut Command X

Cut F2

Copy Command C

Copy F3

Paste Command V

Paste F4

Clear Whole Object Backspace

Clear Whole Object Delete

Select All Command A

Duplicate Command D

Group Command G

Ungroup Command U

View Menu
L-2



New Window Command K

Look At Selected Command 1

Home View Command H

Home View Home

Custom (View) Command 0

Top (View) Command 5

Front (View) Command 8

Left (View) Command 4

Right (View) Command 6

Back (View) Command 2

Last View Command 9

Last View End

Options Menu

Edit Item Command E

Lock Command L

Autogrid Command Y

Metric Command M

Inches Command I

Spin around Look At Command T

Plug-in Menu

Last Plug-in Command *

Help Menu

Online Manual Help

Others

Refresh F5

Action Command Key
L-3
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